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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©August 2012

Trademarks
Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive

Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

EuP-Standby and Off Mode Power Consumption Statement:

Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode or standby mode:

o Standby Mode <2W
« Off Mode <1w
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

\ A/
L&
Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the Bluetooth/Wireless LAN modules
at the same time as this may disrupt radio frequency, and cause interference. When the 3G module is powered on, make
sure that the Bluetooth/Wireless LAN modules are powered off.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed bel ow, to reduce therisk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC
Output of 19V, 4.74A (90 Watts) minimum AC/DC Adapter.

This Computer’s Optical Device is a Laser Class 1 Product

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

surface.

Do not placeit on an unstable

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

VIiI

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.




Power Safety

The computer has specific power requirements:

* Only use a power adapter approved for use with this computer.

* Your AC/DC adapter may be designed for international travel but it still requiresa
steady, uninterrupted power supply. If you are unsure of your local power specifications,

consult your service representative or local power company.

» The power adapter may have either a 2-prong or a 3-prong grounded plug. The third
prong is an important safety feature; do not defeat its purpose. If you do not have access

to acompatible outlet, have a qualified electrician install one.

*  When you want to unplug the power cord, be sure to disconnect it by the plug head, not

by itswire.

* Make sure the socket and any extension cord(s) you use can support the total current

load of all the connected devices.

» Before cleaning the computer, make sure it is disconnected from any external power

supplies (i.e. AC/DC adapter or car adapter).

cord if you are wet.

Do not plug in the power

Do not use the power cord if
it is broken.

Do not place heavy objects
on the power cord.

Preface
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines and

power cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine
on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See a'so the general battery precautionary information overleaf for further information.
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Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

Do not remove any batteries from the computer while it is powered on.

Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

If you do not use the battery for an extended period, then remove the battery from the computer for storage.
Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

K eep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

SN
ALK

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 |If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» If thereisan unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.

Xl
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Travel Considerations

Packing
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwbPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your

computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.

X1l
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’'t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

Adjust the height of the chair and/or desk so that the keyboard is at or dightly below the level
of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a
footrest if necessary.

Use a chair with aback and adjust it to support your lower back comfortably.

Sit straight so that your knees, hips and elbows form approximately 90-degree angles when
you are working.

Take periodic breaks if you are using the computer for long periods of time.

Remember to:

Alter your posture frequently.

Stretch and exercise your body several times a day.

Take periodic breaks when you work at the computer for long periods of time. Frequent and
short breaks are better than fewer and longer breaks.

XV
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatiguein your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plansto turn the screen off after afew minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.

|
XVI
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,
optical device, card reader), Touchpad & Mouse, Audio & Printer.

e Chapter 3  The computer’'s power saving options.

e Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

» Chapter 6 Instructionsfor upgrading your computer.

e Chapter 7 A quick guide to the computer’s PC Camera, WirelessLAN, 3G and Bluetooth & WLAN
Combo modules (some of which may be optional depending on your purchase configuration).

e Chapter 8 A troubleshooting guide.

« Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on the Control Center application.

» Appendix C Information on the video driver controls.

» Appendix D The computer’s specification.

. |
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
torefer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “ Upgrading The Computer” on
page 6 - 1 inthe reminder of the User' sManual. Y ou may also find the notes marked with a# of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark | remainder of the User's Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
utors foatiroe. <™ | may find it useful to refer to the notes marked with a s indicated in the margin,
For amore detailed description of any of the interface ports and jacks see “ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.

. |
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System Software

Y our computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 7 (with Service Pack 1 in-
stalled) operating system is supported.

Note: In order to run Windows 7 (SP1) without limitations or decreased performance, your computer requires a
minimum 1GB of system memory (RAM).

4

Windows OS

In order to run Windows 7 without limitations or decreased performance, your computer requires a minimum 1GB of sys-
tem memory (RAM), however if you are running Windows 7 64 bit your computer requires a minimum 2GB of system
memory (RAM).

. |
1 -4 Overview
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System Startup

1. Remove all packing materials.

2. Place the computer on a stable surface.

3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

4. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other

hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

4

Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
o Shut Down command
130 from the bottom right of
the Start menu in Win-
dows. This will help
prevent hard disk or
system problems.

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

System Startup 1 -5
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Model Differences

This notebook series includes five models that vary slightly in color and general appearance. The main differ-
ences between the models are indicated in the table below (see “ Specifications’ on page D - 1 for full details).
Both modelsalso include distinct design stylesthat may appear slightly different from those pictured in thisman-
ual.

Feature Model A Model B Model C Model D
Display 15.6"/39.62cm 17.3"/43.94cm 15.6"/39.62cm 17.3"/43.94cm
Type 16:9 Backlit Panel 16:9 Backlit Panel 16:9 Backlit Panel 16:9 Backlit Panel
Co\ggr?)cl)ler Intel® Integrated GPU and NVIDIA® GeForceGT 635M Intel® Integrated GPU and NVIDIA® GeForceGT 645M
3G Module UMTS/HSPDA-based 3G N/A UMTS/HSPDA-based 3G N/A
Module Module
374mm (w) * 250mm (d) 374mm (w) * 250mm (d)
*14.3 - 37.2mm (h) *14.3 - 37.2mm (h)
OR (Design Style 413mm (w) * 270mm (d) OR (Design Style 413mm (w) * 270mm (d)
. . Dependent) * 14 - 40.5mm(h) Dependent) * 14 - 40.5mm(h)
Dimensions . .
& Weight 374mm (w) * 25.0mm (d) 374mm (w) * 25.0mm (d)
*20 - 37.2mm (h) 3kg with ODD & * 20 - 37.2mm (h) 3kg with ODD &
48.84WH Battery 48.84WH Battery
2.6 kg with ODD & 2.6 kg with ODD & 48.84WH
48.84WH Battery Battery

Table 1 - 1 - Model Differences

. |
1 - 6 Model Differences
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LCD Panel Open - Models A/C Figure 1 - 2

o @ LCD Panel Open

7£l§ Models A/C
Wireless Device 1. Built-in PC Camera
Operation Aboard (Optional)
9 Aircraft 2 LCD
The use of any portable electronic 3. Power Button
transmission devices aboard air-
craft is usually prohibited. Make 4. LEI_D Status
sure the module(s) are OFF if you Indicators
are using the computer aboard
aircraft. S. fey_board
Use the key combinations to tog- 6. B_u"t_ln
gle power to the 3G/WLAN/Blue- Microphone
tooth modules, and check the *Note that the
e LED indicator or on-screen icon to microphone location is
see if the modules are powered dependent upon vour
on or not (see P . pony
@ ) model design
). 7. Touchpad &
Buttons

(6]
o

Note that the Touchpad and Buttons valid operational area is that indicated within the red dotted lines

indicated on the right.

LCD Panel Open - Models A/IC1-7
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Figure 1 -3
LCD Panel Open
Models B/D

1. Built-In PC Camera

(Optional)

LCD

Power Button

4. LED Status

Indicators

Keyboard

Built-In Microphone

7. Touchpad &
Buttons

wnN

ou

Note that the Touchpad and
Buttons valid operational area
is that indicated within the red
dotted lines above.

LCD Panel Open - Models B/D
o

1 -8 LCD Panel Open - Models B/D

2 &
Wireless Device

Operation Aboard
Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-

ule(s) are OFF if you are using
the computer aboard aircraft.

Use the key combinations to
toggle power to the WLAN/
Bluetooth modules, and
check the LED indicator or on-
screen icon to see if the mod-
ules are powered on or not
(see /

).
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LED Indicators
The LED indicators on the computer display helpful

Icon Color Description

The (optional) Wireless LAN

information about the current status of the computer. Green :
Module is Powered On
T The (optional) Bluetooth Module
Icon Color Description Orange is Powered On
Orange DC Power is Plugged In Green Hard Disk Activity
Green The Computer is On
Green Number Lock Activated

The Computer is in Sleep

Mode Green Scroll Lock Activated (to activate
press Fn & Scr LK)

Blinking Green

Orange The Battery is Charging

m Green The Battery is Fully Charged Green Caps Lock Activated

The Battery Has Reached

Blinking Orange Critically Low Power Status

Table 1 - 3 - LED Status Indicators

Table 1 - 2 - LED Power Indicators

LED Indicators 1 -9
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4

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys
unique to the system'’s
regular keyboard may not
work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable number
or scroll lock, and check
the LED indicator for sta-
tus.

Keyboard - Models A/C

The keyboard has an embedded numerical keypad for easy numeric data input, and
features function keys to allow you to change operational features instantly. See
Table, on page 1 - 12 for full function key combination details.

| Function Keys

NumLk &
ScrLk Keys

3G Numerical
Module Power Keypad

Toggle Key

Play/Pause Key

[ ]

Fn Key
Figure 1 - 4 - Keyboard - Models A/C

4

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1-10Keyboard - Models A/C
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4

Other Keyboards

Keyboard - Models B/D

The keyboard has an embedded numerical keypad for easy numeric data input, and
features function keys to allow you to change operational features instantly. See

Table, on page 1 - 12 for full function key combination details. If your keyboard is dam-
aged or you just want to

| | |:| make a change, you can

use any standard USB

NumLk & keyboard. The system will
ScrLk Keys detect and enable it auto-
Play/Pause Key matically. However spe-

cial  functions/hot-keys
Numerical unique to the system'’s
Keypad regular keyboard may not
work.
|:| NumLk & ScrLk

Hold down the Fn Key

Fn Key and either NumLk or
F|gure 1 - 5 - Keyboard - MOde|S B/D ScrLk to enable number
or scroll lock, and check
4 the LED indicator for sta-
tus.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Keyboard - Models B/D 1 - 11
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Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility isinstalled.

Keys Function Keys Function
Fn+~ Play/Pause (in Audio/Video Programs) Fn + F8/F9 Brightness Decrease/Increase
En + 3G Module Power Toggle* Fn + F10 PC Camera Power Toggle
Fn+F1 TouchPad Toggle Fn + F11 WLAN Module Power Toggle
Fn + F2 (Press a kg;rtr; t?gsgﬁ)kd?ﬁégjﬁm turn on) Fn + F12 Bluetooth Module Power Toggle
Fn+F3 Mute Toggle Fn + NumLk Number Lock Toggle

Fn + F4 Sleep Toggle Fn + ScrLk Scroll Lock Toggle
Volume Decrease/
Fn + F5/F6 Increase Caps Lock Caps Lock Toggle
Fn+F7 Display Toggle Fn + Esc Toggle Control Center On/Off (see over)

Table 1 - 4 - Function & Hot Key Indicators

1-12 Function/Hot Key Indicators
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Control Center

Press the Fn + Esc key combination, or double-click the icon ﬂ in the notification area of the taskbar to
toggle the Control Center on/off. The Control Center gives quick access to frequently used controls and en-
ables you to quickly turn modules on/off (see Appendix B for full details).

4

Control Center

Click on any button to turn any of the modules (e.g.
TouchPad, Camera) on/off.

Click on the power conservation modes to switch
between Performance, Balanced or Energy Star
modes (see page 3 - 10). To remove the Power
Conservation Modes screen just click in a blank
area of the icon or press a key on the keyboard.

Click on the buttons (or just click and hold the
mouse button) to adjust the slider for Brightness/
Volume.

Click on Display Switch and click to choose a dis-
play mode from the menu (see page C - 12).

Table 1 -5 - Control Center

Control Center 1 - 13
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Figure 1 -6
Front & Left Views
Models A/C

1. LED Power Indica-
tors (see Table 1 -
2,0onpagel-9)
DC-In Jack
External Monitor
Port

RJ-45 LAN Jack
HDMI-Out Port

2 *USB 3.0 Ports
Vent/Fan Intake
e-SATA Port
Multi-In-1 Card
Reader

wnN

© N GaA

Front & Left Views - Models A/C
(1)

(8]
9@966039
4

Multi-In-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo

USB 3.0 Port OR USB 2.0 Port
This computer model series has two USB 3.0 ports on the left side of the computer. USB
3.0 ports are denoted by their blue color; USB 2.0 ports are colored black.

Note that USB 3.0 ports require a driver installation (see “USB 3.0” on page 4 - 7) and
does not support wake on USB.

1-14 Front & Left Views - Models A/C
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Front & Left Views - Models B/D Figure 1 - 7
Front & Left Views
Models B/D
(1) 1. LED Power Indica-

tors (see Table 1 -
2,0onpagel-9)
DC-In Jack
External Monitor
Port

RJ-45 LAN Jack
HDMI-Out Port

2 *USB 3.0 Ports
Vent/Fan Intake
e-SATA Port
Multi-In-1 Card
Reader

wnN

Multi-In-1 Card Reader

© NG A

The card reader allows you to use the most popular digital storage card formats:
MMC (MultiMedia Card) / RS MMC

SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo
USB 3.0 Port OR USB 2.0 Port
This computer model series has two USB 3.0 ports on the left side of the computer. USB
3.0 ports are denoted by their blue color; USB 2.0 ports are colored black.

Note that USB 3.0 ports require a driver installation (see “USB 3.0” on page 4 - 7) and
does not support wake on USB.

Front & Left Views - Models B/D 1 - 15
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Figure 1- 8 Right & Rear Views - Models A/C

Right & Rear Views
Models A/C

1. Microphone-in
Jack 09 9 9
2. Headphone-Out
Jack
3. USB 2.0 Port
4. Optical Device

Drive Bay
5. Security Lock Slot
6. Battery ﬁ

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may
push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened
pencil or any object that may break and become lodged in the hole. Don't try to remove a floppy disk/
CD/DVD while the system is accessing it. This may cause the system to “crash”.

Disk Eject Warning

Don't try to eject a CD/DVD while the system is accessing it. This may cause the system to “crash”.
Stop the disk first then eject it, or press the stop button twice.

1-16 Right & Rear Views - Models A/C
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CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may
push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened
pencil or any object that may break and become lodged in the hole. Don't try to remove a floppy disk/
CD/DVD while the system is accessing it. This may cause the system to “crash”.

Disk Eject Warning

Don't try to eject a CD/DVD while the system is accessing it. This may cause the system to “crash”.
Stop the disk first then eject it, or press the stop button twice.
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Figure1-9
Right & Rear Views
Models B/D

1. Microphone-In
Jack

2. Headphone-Out
Jack

3. USB 2.0 Port

4. Optical Device

Drive Bay
5. Security Lock Slot
6. Battery

.|
Right & Rear Views - Models B/D 1 - 17
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Figure 1 - 10 Bottom View - Models A/C

Bottom View
Models A/C

Battery 0
2. Component Bay 9

Cover 9

3. Vent/Fan Intake/

Outlet e

4. Hard Disk Bay
Cover 9

5. Speakers 9

=

CPU

The CPU is not a user
serviceable part.

Overheating

To prevent your comput-
er from overheating
make sure nothing blocks Always completely discharge, then fully charge, a new battery before using it. Completely
the Vent/Fan Intake while discharge and charge the battery at least once every 30 days or after about 20 partial dis-
the computer is in use. charges. See “Battery Information” on page 3 - 11 for full instructions.

Battery Information
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Bottom View - Models B/D
(1)

4

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 11 for full instructions.

Quick Start Guide

Figure1-11
Bottom View
Models B/D

=

Battery

2. Component Bay
Cover

3. Fan Intake/Vent

4. Hard Disk Bay
Cover

5. Speakers

CPU

The CPU is not a user
serviceable part.

Overheating

To prevent your comput-
er from overheating
make sure nothing
blocks the Vent/Fan In-
take while the computer
is in use.
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3G Module USIM Card Installation

If you have included an optional 3G modulein your purchase option (Factory Option for Model A & C Com-
puters Only), follow the instructions below to install the USIM card (which will be provided by your service
provider), and then run the Wir eless M anager application. See“ Wireless Manager” on page 7 - 34 for instruc-
tions on installing the program etc.

1. Turn off the computer, and turn it over and then remove the battery (slide the latches in the direction indicated
below and slide the battery out).

2. Insert the USIM card (at the rear of the battery compartment) as illustrated below until it clicks fully into position,
and replace the battery.

USIM Card
Orientation

Note that the USIM
card’'s readable side
(with the gold-colored
contacts) should face
upwards as illustrated.

Figure 1 - 12 - Battery Removal & USIM Card Insertion

1-20 3G Module USIM Card Installation



Quick Start Guide
Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usualy be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Propertiesif you want to customize the appearance of the Start menu.

Click here to toggle Category View

Figure 1 - 13 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
inWindows (e.g. power, video, network, audio etc.). Windows 7 provides basic controlsfor many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

3G Module USIM Card Installation 1 - 21
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Video Features

NVIDIA® Optimus™ Technology

NVIDIA® Optimus™ technology is a seamless technology designed to get best performance from the graphics
system while allowing longer battery life, without having to manually change settings. The computer will auto-
matically switch between the integrated UMA (Unified Memory Architecture) GPU (iGPU) and the discrete
GPU (dGPU) when required by the applicationsin use.

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Per sonalization) in Windows 7 (see over). For more detailed video information see “ Video Driver Con-
trols’ on pageC - 1.

1-22 Video Features
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To access Display (Control Panel) and Screen Resolution in Windows:

Click Start and click Control Panel.

Click Display (icon) - In the Appearances and Personalization category.

Click Adjust Screen Resolution/Adjust resolution.

Alternatively you can right-click the desktop and select Screen resolution.

Use the dropbox to select the screen Resolution @ (Figure 1 - 14).

Click Advanced settings @ (Figure 1 - 14) to bring up the Advanced properties tabs.

ok wppE

Figure 1 - 14 - Screen Resolution
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To access the I ntel (R) Graphics and Media Control Panel:

1. Click Advanced settings @ (Figure 1 - 14 on page 1 - 23) in the Display Settings control panel in Windows.
2. Click Graphics Properties (button) @ (Figure 1 - 15) in the Intel Graphics & Media Control Panel tab.

OR

3. Right-click the desktop and select Graphics Properties from the menu.

OR

4. Click the icon H © (Figure 1 - 15) in the taskbar and select Graphics Properties from the menu.

OR

5. Access the Intel(R) Graphics and Media Control Panel from the Windows control panel in Classic View.

6. Choose the application mode (Basic, Advanced or Wizard) required.

8¢ )

C o)

Figure 1 - 15 - Intel Graphics and Media Control Panel
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To access the NVIDIA Control Panel:
1. Right-click the desktop and select NVIDIA Control Panel @ (Figure 1 - 16).
OR

2. Double-click the icon @ (Figure 1 - 16) in the Windows control panel.

C 6)

Figure 1 - 16 - NVIDIA Control Panel
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Power Options

The Power Options (Hardwar e and Sound menu) control panel icon in Windows (see page 1 - 19) alowsyou
to configure power management features for your computer. Y ou can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create anew plan. Click Change plan settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “ Battery Information” on page 3 - 11.

Figure 1 - 17 - Power Options

1 - 26 Power Options



Features & Components

Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical (CD/DVD) Device
Multi-In-1 Card Reader
TouchPad and Buttons/Mouse
Audio Features

. |
Overview 2 - 1



Features & Components

Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height

Before attempting to ac- of 9.5 mm.

cess any of the internal

Colaeniepie Sl The hard disk is accessible from the bottom of your computer as seen below. For fur-
el CEECENENIERE  ther details see “ Upgrading the Hard Disk Drive” on page 6 - 5.
that the machine is not

connected to the AC

power, and that the ma-

chine is turned off. Also

ensure that all peripher-

al cables, including

phone lines, are discon-

nected from the comput-

er.

SN
ALK

Power Safety

Figure2-1
Hard Disk Location

2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device

Thereisabay for a5.25" optical (CD/DVD) device (12.7mm height). The actual de- Z

vice will depend on the module you purchased (see “ Storage” on page D - 5). The Sound Volume
optical device is usualy labeled “Drive D:” and may be used as a boot device if Adjustment
properly set inthe BIOS (see “Boot Menu” on page 5 - 12). How high the sound vol-

ume can be set depends

Loading Discs on the setting of the vol-
ume control within Win-

Toinsert aCD/DVD, press the open button @ and carefully place aCD/DVD onto | gows. Click the Volume
thedisc tray with label-side facing up (usejust enough forcefor thedisctoclick onto | icon on the taskbar to
the tray’ s spindle). Gently push the CD/DVD tray in until itslock “clicks’ and you | check the setting (see
are ready to start. The busy indicator @ will light up while datais being accessed, | Audio Features® on

or while an audio/video CD, or DVD, isplaying. If power isunexpectedly interrupt- page 2- 18).
ed, insert an object such as a straightened paper clip into the emergency gject hole
© to open thetray. :
Figure2 -2

Optical Device

Optical (CD/DVD) Device 2 - 3
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- Handling CDs or DVDs

7[:1‘ Proper handling of your CDS/DVDs will prevent them from being damaged. Please
@0 ==l follow the advice below to make sure that the data stored on your CDs/DV Ds can be

accessed.
If you need to manually

i e GRS Note the following:
an unexpected power

WEREED RS EEUEVAR  «  Hold the CD or DVD by the edges; do not touch the surface of the disc.
Eﬂzrghtfnee . eg:pe?fcnz « Useaclean, soft, dry cloth to remove dust or fingerprints.
et teel © Do not write on the surface with a pen.

WG ERNEVESEEEE SRl o Do not attach paper or other materials to the surface of the disc.
CCRNOIRTECECESEE ]« Do not store or place the CD or DVD in high-temperature areas.
SRR . Do not use benzene, thinner, or other cleanersto clean the CD or DVD.
S B . Do not bend the CD or DVD.

and become lodged in -
the hole. * Do not drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes

To change the DVD regional codes: Z

1. Go tothe Control Panel DVD Region Note
2. Double-click Device Manager (Hardware and Sound), then click the + next to DVD region detection is
DVD/CD-ROM drives. device dependent, not
3. Double-click on the DVD-ROM device to bring up the Properties dialog box, and 0S-dependent. You can
select the DVD Region (tab) to bring up the control panel to allow you to adjust the select your module’s re-
regional code. gion code 5 times. The
« Region 1-USA & Canada fifth sele_ction is perma-
) nent. This cannot be al-
* Region 2 - Western Europe, Japan, tered even if you change
South Africa, Middle East & Egypt your operating system

or you use the module in

+ Region 3 - South-East Asia, Taiwan, another computer.

South Korea, The Philippines, Indo-
nesia, Hong Kong
* Region 4 - South & Central Amer-
ica, Mexico, Australia, New Zealand
* Region 5- N Korea, Russia, Eastern
Europe, India& Most of Africa
« Region 6 - China Figure2- 3
DVD Region Codes

Optical (CD/DVD) Device 2 - 5
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Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure2-4
Left View

1. Card Reader

Multi-In-1 Card Reader

The card reader alows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“ CardReader” on page 4 - 6.

« MMC (MultiMedia Card) / RSMMC

» SD (Secure Digital) / Mini SD / SDHC/ SDXC
* MS(Memory Stick) / MSPro/ MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the
cards.

2 - 6 Multi-In-1 Card Reader
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TouchPad and Buttons/Mouse

The TouchPad is an aternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. Install the driver as instructed in This Com?ut?r mzqﬁel SE;
“ " H H H : H rnes may fteature dirreren
_ Touchpad” on page 4 - 6 and the appropriate application software version will be TolchPad versions.
installed for your computer.

TouchPad Scrolling

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require  tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

TouchPad and Buttons/Mouse 2 - 7
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4

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device's user docu-
mentation for details.

Figure2-5
Mouse Properties
(ELAN tab) &
Taskbar Icon

Elan TouchPad

Once you have installed the TouchPad driver (see “ Touchpad” on page 4 - 6) you
can configure the functions by double-clicking the TouchPad driver icon  inthe
notification area of the taskbar (or from Optionsin the ELAN tab in the Mouse
control panel in Windows). Y ou may then configure the gestures and optionsto your

preferences.
O O

-

2 - 8 TouchPad and Buttons/Mouse
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The Elan Smart-Pad control panel allows you to use a specific gesture (action) on
the surface of the TouchPad to perform specific actions to manipulate documents,
objects and applications.

Click the menu tabs (One-finger, Multi-finger or Additional) and then the function
button on the left to access the Configuration controlsin the right panel. Click the
checkbox to Enable most of the controls and click Apply to save the settings. Click
thecloseicon or Yesto close the control panel.

>

Figure2-6
Smart-Pad Control
Panel (Button)

TouchPad and Buttons/Mouse 2 - 9
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Click the Function Description [ ] button to get a detailed description of any func-
tion.

Click the Default e button to set any of the functions to the default setting.

-

Figure2-7
Smart-Pad Control
Panel with
Function
Description

2 - 10 TouchPad and Buttons/Mouse
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One-Finger

Tapping

The Smart-Pad supports one, two and three finger tapping, al configured from the
Tapping control panel inthe One-finger tab. Y ou can configure two or threefinger
tapping to perform a number of different functions by selecting them from the drop-

down menus provided.

Figure2-8
Tapping
Button
The left and right TouchPad buttons may be configured to perform any action listed
in the Button drop-down menu.
Figure2-9
Button

. |
TouchPad and Buttons/Mouse 2 - 11
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Figure2- 10
Drag and Drop

Figure2-11
Edge Scroll

Drag and Drop

Y ou can select the different drag and drop methods from the menu provided. The ob-
ject can be released when you lift the finger off the TouchPad, when you tap again
or after a set time delay.

Edge Scroll

Edge Scroll can be configured to use a single finger to scroll vertically or horizon-
taly. To scroll vertically, tap the right edge of the TouchPad and drag the finger up
and down. To scroll horizontally, tap the bottom edge of the TouchPad and drag your
finger left or right.

2 - 12 TouchPad and Buttons/Mouse
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Multi-Finger

Zooming
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

Figure2 - 12
Zooming
Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Tap the pad surface and slide both fingersin the
direction required (vertically or horizontally aslong as the option is selected).
Figure2- 13
Scrolling

. |
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Rotation

Y ou can rotate objects by using atwo-finger gesture. Touch and rotate using two fin-
gers on the pad in the direction required. Alternatively place a finger down on the
pad and rotate the other finger around it in a circular motion (clockwise or counter-

clockwise).

Figure2- 14

Rotation

Swipe Page
Thisgestureisused to activate a Page Up/Page Down operation. Swipethreefingers
quickly to the left to go to the previous page, or to the right to go to the next page.
After you release your fingers from the pad the page changes, and make sure to lift
your fingersimmediately after the page change.

Figure2- 15

Swipe Page

. |
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Fast Keys
The Fast Keys gesture alows you to switch windows or open My Computer. 2

Figure2- 16
Fast Keys

My Computer (Fast Keys)
Tap three fingers simultaneously on the pad and then move them up until you get to
the My Computer window, you can then release the fingers from the pad.

Switch Windows (Fast Keys)
Tap three fingers simultaneously on the pad and then move them down until the ac-
tivewindow switches, you can then use asinglefinger to select the window required.

. |
TouchPad and Buttons/Mouse 2 - 15
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Additional
Palm Tracking
Thisfeature helps guard against accidental contact such as palms resting on the pad.
Use the dlider to adjust the sensitivity of the feature as appropriate.

Figure2- 17
Palm Tracking

Smart Motion

Smart Motion makes it easier to drag objects across the screen or move the pointer
across long distances. When a finger reaches the edge of the TouchPad, holding the
finger on the edge of the TouchPad will allow the cursor to continue moving until
the finger islifted.

Figure2- 18
Smart Motion

. |
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Slow Motion
Slow Motion allows you to slow down the cursor movement for more precise con-
trol. Pressing and holding key (configured from the drop-down menu) will enable
this feature.
Figure2- 19
Slow Motion

. |
TouchPad and Buttons/Mouse 2 - 17
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Audio Features

Y ou can configure the audio options on your computer from the Sound  control
panel in Windows, from the HD V Deck icon on the desktop or VIA HD Audio
Deck control panel 2| via +p Audio Deck .

4

Sound Volume
Adjustment

The sound volume level

is set using the volume | The volume may also be adjusted by means of the Fn + F5/F6 key combination.
control within Windows

(and the volume func-

tion keys on the comput-

er). Click the volume

icon in the taskbar to

check the setting.

Figure2 - 20
VIA HD Audio Deck

2 - 18 Audio Features
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Expert Mode will alow you to access more advanced configuration menus for "
Speaker, Microphone and Stereo Mix. ZX

Syncing Left & Right
Volume
Balance

If you wish to adjust the left
and right channel volume
levels separately, you will
need to adjust this from the
VIA HD Audio Deck in Ex-
pert Mode.

Click Speaker in VIA HD
Audio Deck (in Expert
Mode) and click the Sync
Left and Right volume
button (see left). You can
then adjust the volume slid-
ers independently (this set-
ting also controls the
Balance setting in the Win-
dows Sound control pan-
el).

Figure2-21
VIA HD Audio Deck
(Expert Mode)

Audio Features 2 - 19
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Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

. . functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on_ your

(the LCD and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is

« The Power Sources best to refer to the user’s

* Turning On the Computer ENE ©F o EREE:
ing system.

« Power Plans

» Power-Saving States (Note: All pictures used

» Configuring the Power Buttons on the following pages

are from the Windows 7

* Power Conservation Modes
0S))

» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OSto set devicesinto low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1



Power Management

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see“How do | completely discharge the battery?”

on page 3 - 15).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 11.

3 - 2 The Power Sources
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Turning On the Computer P

Now you are ready to begin using your computer. To turnit on simply pressthe pow-
er button on the front panel. Forced Off

] . If the system “hangs”,
When the computer is on, you can use the power button as a Stand by/Hibernate/ and the Ctrl + Alt + Del

Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and | key combination doesn't

holding the power button for longer than this will shut the computer down). Use | work, press the power

Power Optionsin the Windows control panel to configure this feature. button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

/ Power Button as
Shut Down Stand by or

. Hibernate Button
Note that you should always shut your computer down by choosing the Shut Down com-

mand from the bottom right of the Start menu in Windows. This will help prevent hard disk You can use the OS's

or system problems. Power Options control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 8 for details).

Turning On the Computer 3 - 3
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4

Resuming
Operation

See Table3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-1
Power Plan
Advanced Settings
(Win 7)

Power Plans

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

> >

3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-

chine in order to save power. Thisisworth bearing in mind if you are experiencing Z
any reduced performance (especialy under DC/battery power). UMA Mode Power Plan
Choose High performance (you may need to click Show additional planstoview | UMA Mode is used for con-

the High performance plan) for maximum performance when the computer is pow- fr:i‘g;f:t‘gsrég‘angn"l";h;x
ered from an AC power source. Choose the Power saver (bear in mind that this | umA Mode power plan's
scheme may slow down the overall performance of the computer in order to save | standard settings are also
power) for maximum power saving when the computer is baitery (DC power) pow- | pepdtisd 1o eafe e
ered (see sidebar for UM A M ode power plan information). The recommended Bal- | if selected.

anced power plan will balance power saving and performance.

Click to Show/Hide

additional

power plans i
Figure3- 2

Power Plans

Power Plans 3 - 5
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Power-Saving States

Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Win 7 uses the Sleep, Hiber nate and Shut Down power-saving states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save al the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3 - 6 Power-Saving States



Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occursthe system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. Y ou should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down

Y ou should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

.|
Power-Saving States 3 - 7
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Figure3-3
Start Menu Power
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Configuring the Power Buttons

Z The power/seep button (Fn + F4 key combo) and closed lid may be set to send the
Password computer in to a power-saving state. Click Choose what the power buttons do on
Protection the left menu in Power Options to bring up the menu.

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-4
Power Options
Define Power
Buttons

.|
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Resuming Operation

Y ou can resume operation from power-saving states by pressing the power button, Z
or in some cases pressing the sleep button (Fn + F4 key combo). Closing the Lid
If you have chosen to
Power Status Icon Color To Resume send the computer to
Sleep when the lid is
Power Off Off Press the Power Button closed, raising the lid

Press the Power Button SIE SR U

Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery) Table3-1
Hibernate Press the Power Button Resuming
Orange (AC/DC adapter) .
Operation
Display Turned Off Green Press a Key or Move the Mouse/Touchpad
Power Button 3G Modules &
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down System Wake Up

hot key button when it is pressed for less than 4 seconds (pressing and holding the power

button for longer than this will force the computer to shut down). R 66 MmotllEs

DO NOT support system
wake up on 3G modem
activity.

Configuring the Power Buttons 3 - 9
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Power Conservation Modes

g This system supports Energy Star power management features that place comput-
3 Power Conservation ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
Modes of inactivity. Adjust Power Conservation Modes from the Control Center:

The Energy Star setting 1. Pressthe Fn + Esc key combination to toggle the Control Center on/off.
will result in maximum & 2 Click either the Performance, Balanced or Energy Star button.
power saving, but with 3. Click in a blank area of the icon or press a key on the keyboard to exit Power

the possible loss of Conservation Mode without making any changes.
some performance.

Setting the mode to Bal-
ance will give power
saving matched with
performance.

Performance will give
optimum computer per-
formance but with less
power conservation.

Figure3-5

Control Center

3 - 10 Configuring the Power Buttons
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Battery Information -
Follow these simple guidelines to get the best use out of your battery.

/s \§

Low Battery
Battery Power Warning

Y our computer’ s battery power is dependent upon many factors, including the pro- B E S ok
grams you are running, and peripheral devices attached. You can set actions to be gecUAEIERIEE R
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from [l s acible
power plan Change plan settings > Change advanced power settings(see Figure adapter to the computer

or save your work, oth-
3-1onpage3-4). erwise, the unsaved

. . . data will be lost when
Click the battery icon [ in the taskbar to see the current battery level and charge BTSN ol

status.

Figure3-6
Battery Icon
(Taskbar) & Battery
Advanced Settings

.|
Battery Information 3 - 11
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Conserving Battery Power

4 » Useapower plan that conserves power (e.g Power saver), however note that
Windows Mobility this may have an affect on computer performance.
Center » Lower the brightness level of the LCD display. The system will decrease LCD
The Windows Mobility brightness slightly to save power when it is not powered by the AC/DC adapter.

Center control panel ) . .
provides an easy point | °* Reducethe amount of time before the display isturned off.

of access for information § , | ose wireless, Bluetooth, modem or communication applicationswhen they are
on battery status, power

plans used and wireless not being used.
device status etc. « Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.

Figure3-7
Windows Mobility
Center

.|
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improveits performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see“ Removing the Battery”
on page6 - 4.

New Battery

Always completely discharge, then fully charge, a new battery (see “ Battery FAQ”
on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. (Refer to“ LED Indica-
tors’ on pagel - 9 for information on the battery charge status, and to “ Battery
FAQ" on page 3 - 15 for more information on how to maintain and properly re-
charge the battery pack.)

.|
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Proper handling of the Battery Pack

ﬂ‘ * DO NOT disassemble the battery pack under any circumstances
Caution * DO NOT expose the battery to fire or high temperatures, it may explode

5 o * DO NOT connect the metal terminals (+, -) to each other
anger of explosion if

battery is incorrectly re-
placed.

2MN\L
I

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being

dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to alow battery. Don't

turn off the computer even if amessage indicates the battery iscritically low, just let
the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure3-8
Power Plan Create
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure3-9
Change Plan
Settings / Change
Advanced Power
Settings
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure3- 10
Power Options
Advanced Settings -
Battery

* Low battery levels= 0%

» Critical battery Levels=1%

» Low battery action = Do Nothing

 Critical battery action (On battery) = Shut Down
 Critical battery action (Plugged in) = Do Nothing

.|
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Chapter 4: Drivers & Utilities

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which thelatest versions of most avail able op-
erating systems haven't built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install

The Device Drivers & Utilities + User’sManual disc containsthe drivers and util-
ities necessary for the proper operation of the computer. Table4 - 1, on page4 - 3
listswhat you need toinstall and it isvery important that thedriversareinstalled
in the order indicated.

Module Driver Installation

The procedures for installing drivers for the PC Camera, Wireless LAN, 3G and
Combination Bluetooth & WL AN modules are provided in “ Modules & Options’
on page7 - 1.

What to Install 4 - 1

Drivers & Utilities

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).




Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities+ User’s Manual
discand click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

Figure4 - 1 - Drivers Installer Screen 1

Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
this order) which is the same as that listed in the
Drivers Installer menu below.

Click to select the driver you wish to install, (you
should note down the drivers as you install them).
Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

Figure4 - 2 - Drivers Installer Screen 2
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Windows 7 (SP1) Driver Page # Windows 7 (SP1) Driver Page #
Chipset Page 4 -6 MEI Driver Page 4 -7
Video (VGA) Page 4 -6 Audio Page 4 -7
NVIDIA Video (VGA) Page 4 -6 PC Camera Module Page 7-3
LAN Page 4 -6 Wireless LAN Module Page 7 - 10

3G Module
CardReader Page 4 -6 (for Models A & C Only) Page 7 - 31
Touchpad Page 4 -6 Bluetooth & WLAN Combo Module Page 7 - 56
i Intel Rapid Storage Technology (required i
Hot Key Page 4 -7 for hard disks in AHCI modes) Page 7- 77
USB 3.0 Page 4 -7 THX TruStudio Pro Audio Page 7 - 78
Note all drivers provided are for Windows 7 | 'Nté!® Smart Connect Technology Page 7 - 83
with Service Pack 1. Intel® Wireless Display Application Page 7 - 87

Table4 - 1 - Driver Installation
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.
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Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Updatein order to get all the latest security
updatesetc. (all updateswill includethelatest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

Drivers & Utilities

New Hardware Found

If you see the message “New Har dwar e Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. PC Camera, WLAN or 3G)
are ON before installing the appropriate driver.

Driver Installation 4 - 5
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Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click Llnstall Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

NVIDIA Video (VGA)

1. Click 3.Install nVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to
accept the terms of the license agreement.

3. Click Next.
4. Click the RESTART NOW button to restart
the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 settings to the highest resolution.

LAN

1. Click 4.Install LAN Driver > Yes.
2. Click Next > Install.

3. Click Finish.

CardReader
1. Click 5.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 6.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.
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Hot Key

1. Click 7.Install Hotkey AP > Yes.
2. Click Next > Next.

3. Click Finish > Finish to restart the computer.

USB 3.0

1. Click 8.Install USB 3.0 Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

MEI Driver

1. Click 9.Install MEI Driver > Yes.
2. Click Next > Yes> Next.

3. Click Finish.

Drivers & Utilities

Audio

1. Click 10.Install Audio Driver > Yes.

2. Click Next.

3. Click the button to agree to the license and
click Next.

4. Click Next > Next > Next.

5. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, gect
the Device Drivers & Utilities + User’s Manual disc
and thenreinsert it (or double-click thedisciconinMy
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

It isrecommended you now also install the Intel Rap-
id Storage Technology driver (see“ | RST Driver In-
stallation” on page 7 - 77 - required for AHCI mode
hard disks).

(see over)
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4
Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Click Windows Update (System and Security/
Security).

3. Click Check for updates (button).

4. The computer will now check for updates (you
need to be connected to the internet).

5. Click Install now (button) to begin checking for the
updates.

6. Click Install updates (button) to install the
updates.

Windows Experience Index

After the drivers are installed follow this procedure to

ensure an accurate rating from the Windows Experi-

ence I ndex (make sure the AC/DC adapter is plugged
in):

1. Click Sart, and click Control Panel.

2. Click Performance Information and Tools
(System and Security > System > Check the
Windows Experience I ndex).

3. Click “Ratethis computer/Refresh Now/Re-
run the assessment”.

4. The computer will take afew minutesto assess
the system performance.

5. Close the control panel.

4 - 8 Driver Installation



Drivers & Utilities

Optional Drivers

See the pages indicated in Table 4 - 1, on page 4 - 3 for the driver installation procedures for any modules in-
cluded in your purchase option.

Figure 4 - 3 - Drivers Installer - Option Drivers Menu

Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.

. |
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Chapter 5: BIOS Utilities "

7

Overview BIOS Screens

This chapter gives a brief introduction to the computer’ s built-in software: RIS IO

screens pictured on
o these pages are intend-
If your computer has never been set up, or you are making important changesto the BSERERENEERC s

system (e.g. hard disk setup), then you should review this chapter first and note the  BRIRIEEREENERIE A Sl

original settings found in Setup. Even if you are abeginner, keep arecord of the set-  [REISES

tings you find and any changes you make. This information could be useful if your ~ BESSFREEERETE

system ever needs servicing. ject to constant change
and revision, therefore

There is one general rule: Don’t make any changes unless you are sure of what you  JARSEI SRRl

aredoing. Many of the settings are required by the system, and changing them could [ siada e e

. ) slightly different from
cause it to become unstable or worse. If you have any doubts, consult your service BESSESTERRRIFETE S

representative. pages.

. |
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Pre-
vious Values with
<F2>, or Optimized De-
faults with <F3>.

The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there
isaproblem that prevents the system from booting, it will display asystem summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can't get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot L ogo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a*“Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is aready on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
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4

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Figure5-1
Navigation Menu

Setup Screens

The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up aGeneral Help screen, and then use
the arrow keysto scroll up or down the page.

Theltem Specific Help onthe upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow p next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

System Date:

Figure5-2
Main Menu

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will aso change
these settings. Some applications may also alter data files to reflect these changes.
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System/Extended Memory (Main Menu)
Thisitem contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

MB Series/ BIOSRevision / KBC/EC firmware Revision (Main Menu)
This item contains information on the BIOS version etc., and is not user configu-
rable.
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Advanced Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Figure5- 3
Advanced Menu

P Advanced Chipset Control

Advanced Chipset Control (Advanced Menu)
The sub-menu here alows you to adjust the Bluetooth Power Setting.
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Bluetooth Power Setting (Advanced Menu > Advanced Chipset Control)

Y ou can adjust the Bluetooth module power setting to your preference. The default
setting (Disabled) will see the Bluetooth module powered off when the system is
started up or restarted. Enabling the power setting will have the module retain the
last power status (on or off) before any restart or shut down.

Intel Smart Connect Technology (Advanced Menu)

Smart Connect is a technology that makes checks on web applications that are
open, when the computer isin Sleep mode, and thus all ows updates to be made with-
out the need to turn the computer on. The sub-menu here alows you to enable/dis-
able the technology itself (ISCT Configuration). See “Intel® Smart Connect
Technology” on page 7 - 83.

Intel Anti-Theft Technology (Advanced Menu)

Anti-Theft Technology, which is built-in to the processor of the computer, allows
system administrators to render your computer useless to thieves by sending a poi-
son pill encrypted SM S message over a 3G network etc. Administrators can al'so re-
motely unlock a recovered computer quickly, or direct the system to send location
information (GPS coordinates) back to a central server.
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SATA Mode (Advanced Menu) "

Y ou can configure SATA (Serial ATA) control to operate in | DE (native/compati- ﬂt

ble) or AHCI (Advanced Host Controller Interface) modes from this menu. The SATA Mode

SATA M ode should be set BEFORE installing an oper ating system, and after you Selection

have backed up all necessary files and data (see sidebar). Install the Intel Rapid _

Storage Technology to support your SATA driveif set up in AHCI mode (see” I ntel 'va.yf ; of\',\?;' - ;ns;ﬂﬁitfzg

Rapid Storage Technology” on page 7 - 77). system with either IDE
or AHCI mode enabled,

Boot Logo (Advanced Menu) DO NOT disable the set

Use this menu item to enable/disable the Boot L 0ogo screen at system startup. If you B eEEN RN IRERE S
disable the Boot Logo you will not see the F2 Enter Setup or F7 Boot Options S EEE Sl el
prompts on the screen, however you can still press these keys, while the boot screen [l REREIEEIRUS
L . . Windows 7 OS).
isdisplayed, to perform the Enter Setup or Boot Option functions.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Security Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

4

Security Menu

Security

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Set Supervisor Password:

Figure5-4
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
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Set User Password (Security Menu) "
Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill 7£,1<
not affect access to the computer OS, (only the Setup utility) unless you choose to Password Warning
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility

cannot be modified in user mode. If you set a boot pass-
word (Password on boot

Note: You can only set the user password after you have set the supervisor pass- B 5 =EGEB N VS
word. forget your password.

] The consequences of
Password on boot: (Security Menu) this could be serious. If

Specify whether or not a password should be entered to boot the computer (you may AR U EniSuEEs

. . . “ ” your boot password you
only set a password on boot if a supervisor password is enabled). If “Enabled S R DD Y

is selected, only users who enter a correct password can boot the system (see the BTSRRI EVAE S

warning in the sidebar). The default setting is“Disabled”. of the information on
o o your hard disk.
Note: To clear existing passwords press Enter and type the existing password, then

press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.
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Boot Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.
Boot

Figure5-5

Boot Menu Boot Option #1 [P4: TSSTcorp CDDVIN. .. ]

AN
I

BIOS Screens

Note that the BIOS
screens  pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub- S . .
e et When you turn the computer on it will look for an operating system (e.g. Windows

and revision, therefore 7) from the devices listed in this menu, and in this priority order. If it cannot find
your computer's actual the operating system on that device, it will try to load it from the next device in the
Sl‘?ri‘:lns d_rfr;ay tapfear order specified in the Boot Option Priorities. Item specific help on the right is
tsh'gse ypi ctl:ree éegn threosrz avail able_to help you move devices up and down the order. Pr%_s Enter to select the
pages. Boot Option # device menu, use the arrow keys to select a device, and press Enter

again to confirm the selection.

. |
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Boot Option Priorities (Boot Menu)

Use the arrow keys to move up and down the menu, and go to either Network De-
vice BBS Priorities, CD/DVD ROM Drive BBS Priorities or Hard Drive BBS
Priorities.
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Exit Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Figure5-6 —
Exit Menu

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to its original state, and erase any previous changes you have madein
aprevious session.

. |
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Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problemsyou can con-
tact your service representative for further help. Before you begin you will need:

» A small crosshead or Phillips screwdriver
* A small regular slotted (flathead) screwdriver
e Anantistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

» Upgrading the Hard Disk Drive

» Upgrading the Optical (CD/DVD) Device
» Upgrading the System Memory (RAM)

Please make surethat you review each procedur e before you perform it.

SN
A&

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
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" When Not to Upgrade
7£l< These procedures involve opening the system’ s case, adding and sometimes replac-
Power Safety ing parts.
Warning

Y ou should not perform any of these upgradesif:
Before you undertake

any upgrade proce- * Your system is still under warranty or a service contract
SUICSIUELCEEIEEE] o You don't have all the necessary equipment

CEREREEEREE . You're not in the correct environment
power, and disconnect-

ed all peripherals and * You doubt yOUI‘ abI|ItIeS

cables (including tele- o . .
phone |i£]es andgpower Under any of these conditions, contact your service representative to purchase or re-

el e el place the component(s).
move your battery in or-
der to prevent
accidentally turning the
machine on.

2MN\L
I

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning restoring power to the system.

Also note the following when the cover is removed:

* Hazardous moving parts.
» Keep away from moving fan blades.
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Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with afast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.
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N2
2

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure6-1
Battery Removal

Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.

1. Turn the computer off, and turn it over.

2. Slide the latch @ in the direction of the arrow.

3. Slide the latch @ in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow @.
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Upgrading the Hard Disk Drive g

SN
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard /Ll\
disk drives with a height of 9.5mm (h) (see“ Storage” on page D - 5). Follow your
operating system’ sinstallation instructions, and install al necessary driversand util-

ities (see” Driver Installation” on page 4 - 2), when setting up a new hard disk. New HDD's are blank. Be-
fore you begin make sure:

You have backed up any
data you want to keep from
your old HDD.

HDD System
Warning

You have all the discs re-
quired to install your oper-
ating system and
programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.
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1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws @ & @.
3. Remove the hard disk bay cover @.

Figure6- 2
Hard Disk Bay
Cover Removal
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Upgrading The Computer

Slide the hard disk in the direction of arrow @.

Lift the hard disk out of the bay @. Z
Remove the screw(s) @ - € and the adhesive cover @.

Reverse the process to install a new hard disk drive (do not forget to replace all the Hard Disk Screws &
screws and covers). Cover

The hard disks and cov-
ers pictured here may
appear slightly different

from your model design
9 (these designs are sub-
ject to change and up-
grade without notice).
Pay careful attention to
the screws (if included)
and cover orientation.

(3] @ (6] Figure6-3

@ Hard Disk Removal

Upgrading the Hard Disk Drive 6 - 7




Upgrading The Computer
Upgrading the Optical (CD/DVD) Device

The procedure for removing the optical device will depend upon your particular
computer model:

» See“Removing the Optical Device for Model A/C Computers’ on page 6 - 9.
» See®Removing the Optical Device for Model B/D Computers’ on page 6 - 11.

.|
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Removing the Optical Device for Model A/C Computers

1.
2.
3.

4,

Upgrading The Computer

\ A/
Turn off the computer, and turn it over and remove the battery. 7&‘
Locate the component bay cover and remove screws o -0. _ Fan Cable & Cover
Carefully (a fan and cable are attached to the under side of the cover) lift up
the bay cover. Make sure you recon-
Carefully disconnect the fan cable @, and remove the cover @. nect the fan cable ©
before screwing down
0 the bay cover. Note the
information on replacing
9 the RAM & CPU bay

cover in

Figure6- 4
Removing the
Component Bay
Cover

(6) (6]
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5. Remove the screw at point @.
6. Use a screwdriver to carefully push out the optical device at point €.
7. Reverse the process to install the new device.

Figure6-5
b Removing the
Optical Device (8]

Screw & Optical
Device
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Removing the Optical Device for Model B/D Computers

1.

2.
3.
4

Turn off the computer, and turn it over and remove the battery.

Locate the hard disk bay cover and remove screws @ & @.

Remove the hard disk bay cover @.

Slide the hard disk in the direction of arrow @ and lift the hard disk out of the bay.

(1) (2] o Figure6- 6

Hard Disk Removal
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5. Remove the screw at point @), and use a screwdriver to carefully push out the
optical device at point @.

6. Reverse the process to install the new device.

7. Replace the hard disk bay cover.

Figure6 -7
Removing the
Optical Device @
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Upgrading the System Memory (RAM) -~

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-

DIMM) DDRIII (DDR3) type memory modules (see “ Memory” on page C - 3 for HEEIIG
details of supported module types). Before working with the in-
. ternal components you will
1. Turn off the computer, and turn it over and remove the battery. need to wear an antistatic
2. Locate the component bay cover and remove screws @ - @/@. wrist strap to ground your-
3. Carefully (a fan and cable are attached to the under side of the cover) lift up self because static elec-

tricity may damage the
components.

Fan Cable & Cover

9 9 o Make sure you reconnect
the fan cable 6 before
screwing down the bay

9 9 cover. Note the informa-

tion on replacing the RAM

& CPU bay cover in

the bay cover.
4. Carefully disconnect the fan cable @, and remove the cover @.

Figure6- 8

(7) (7] Removing the

Component Bay

Cover
(6] o [6) (6
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5. Gently pull the two release latches on the sides of the memory socket in the
direction indicated by the arrows (@) & @) in Figure 6 - 9.
6. The RAM module will ¥ pop-up, and you can remove it.

Figure6-9
RAM Module
Removal

D o o

7. Pull the latches to release the second module if necessary.

8. Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory slot.

9. The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit
without much pressure.

10. Press the module in and down towards the mainboard until the slot levers click into
place to secure the module.

.|
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11. Replace the bay cover (see sidebar) and screws (make sure you reconnect the
fan cable before screwing down the bay cover). /
12. Restart the computer to allow the BIOS to register the new memory configuration
as it starts up. Cover Pins

Note that this computer
model has four cover

pins. These pins need to
be aligned with slots in
the case to insure a
proper cover fit, before
screwing down the bay
cover.

Figure6 - 10
Component Bay
Cover Pins

Upgrading the System Memory (RAM) 6 - 15
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Chapter 7: Modules & Options %

4 \

I Wireless Device
OverVIeW Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, depending on the configuration purchased. If you are unsure please  BE e 0 o el
contact your service representative. e_Iectror;ic tﬁgﬁr::;;lgnuzﬁ

*« PC CameraModule * Intel Rapid Storage Technology ;f; Sp?ot?izirted. Make sure
e WirelessLAN Module e THX TruStudio Pro Audio the module(s) are OFF if
+ 3G Module « Intel® Smart Connect Technology g SO

* Bluetooth & WLAN Combo Module « Intel® Wireless Display Application

dNZ
PR

Important Notice

4

Driver Installation &
Module Power

If your purchase option includes both Wireless LAN and 3G modules, then the appropriate antennas
will be installed. Note that In order to comply with FCC RF exposure compliance requirements, the an-
tenna must not be co-located or operate in conjunction with any other antenna or transmitter.

Make sure any modules
(e.g. WLAN, PC Camera,
3G & Bluetooth modules)
are ON before installing the
appropriate driver.

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the Bluetooth/
Wireless LAN modules at the same time as this may disrupt radio frequency, and cause interference.
When the 3G module is powered on, make sure that the Bluetooth/Wireless LAN modules are powered
off.

. |
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PC Camera Module

SN
’ﬁl‘ Before installing the PC Camer a driver, make sure that the optional PC Camerais
I'sa.teSt S Camera on. Usethe Fn + F10 key combination (see Table 1 - 4, on page 1 - 12) or Control
river Information .
Center button to toggle power to the PC Camera module. Make sure you install

SRR the driversin the order indicated in Table 4 - 1, on page 4 - 3.

& Utilities + User’s Manu-

al disc and any accompa- ) ) . )

nying insert pages, for the There are anumber of different cameramodules available with this computer model

latest updated information ; : . . . .
on the PC Camera driver, series. You will have the appropriate application instaled for your camera. Make

which may override the in- sureyou access the application via the desktop shortcut.
formation provided here.

AN
Ik

PC Camera Application and Power-Saving States

PC Camera Display

The PC Camera applica-
tion software needs to be
run while the default note-
book LCD is the selected
display device.

If the computer enters Sleep or Hibernate mode while running the camera application, the
program will stop running, and will need to be restarted when the system resumes from the
power-saving state.

After a camera picture is
obtained on the default
notebook LCD, you may
then use the Fn + F7 to tog-
gle through the display
modes (give the screen
time to refresh).

. |
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PC Camera Driver Installation

\ A/
1. Make sure the moduleis powered on, and then insert the Device Drivers & L&
Utilities + User’s Manual disc into the CD/DVD drive. PC Camera Screen
2. Click Option Drivers (button). Refresh
3. Click 1.Install Webcam Driver > Yes. The PC Camera module
4. Click Finish to restart the Computer. supports a frame rate of
Run the camera application program from the desktop shortcut (if the hard- B BT EREET

wareisturned off use the Fn + F10 key combination to turn it on again). the screen refresh rate
is subject to lag or stut-

tering, then reduce the
window size, or adjust
the Output Size and/or
Color Space Compres-
sion.

To reduce Output Size
and/or Color Space
Compression run the
camera application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate  pull-down
menu.
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is hecessary to setup the
audio recording options in Windows.

PN

o o

©

10.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound).

Click Recording (tab).

Right-click Microphone (VIA High Definition Audio) and make sure the item is not
disabled.

Double-click Microphone (or select Properties from the right-click menu).

Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to
the level required.

Click OK and close the control panels.

Run the camera application program from the desktop shortcut.

Go to the Devices menu heading and select Microphone (VIA....) (it should have
a tick alongside it).

Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).

7 - 4 PC Camera Module
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Figure7-1
Audio Setup for PC
Camera

Right-click
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Camera Application
The cameraapplicationisavideo viewer for general purpose video viewing and test-
ing, and for capturing video filesto .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you
set the capture file before the capture process - see Set Capture File below).

2. Gotothe Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page 7 - 4) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (thiswill help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
“Capturefilesize:” and click OK. Y ou can then start the capture process as above.

Note the important information in “ Reducing Video File Size” on page 7 - 7 in or-
der to savefile space, and help prevent system problems.

. |
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (goto My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires aminimum of 15GB of free space on the C:
drive system partition. In order to prevent system problemsit is recommended that
you save the captured video file to alocation other than the C: drive (see” Set Cap-
ture File” on page 7 - 6), limit the file size of the captured video or reduce video
resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Run the camera application program from the desktop shortcut.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.

4. Click OK.

. |
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™ Eliminating Screen Flicker

ﬂ: If you find that the video screen in the camera program is flickering, you can try to
Latest PC Camera adjust the setting in the Video Capture Filter options.
Driver Information

1. Run the camera application from the desktop shortcut.
Check the Device Driv- 2. Go to Options and scroll down to select Video Capture Filter....
ers & Utilities + User’s 3. Click either 50Hz or 60Hz under PowerLine Frequency.

Manual disc, and any

accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured here.

4

Camera Options

The video capture filter
figure pictured here may
appear slightly different
for some camera mod-
ules. To adjust the anti
flicker properties look un-
der the headings Anti
Flicker/Frequency/Pow-
erLine Frequency.

Figure7-2
Video Capture Filter

. |
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Taking Still Pictures
The camera application allows you to take still pictures. &

1. Run the camera application from the desktop shortcut. Snapshot Folder

2. Goto Options and select Take Picture.

3. The picture (in JPEG format) will be placed in the Snapshot folder on the
desktop.

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you

try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

PC Camera Module 7 - 9
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Wireless LAN Module

Wiraless Devi If you haveincluded an I ntel® or 3rd Party 802.11b/g/n WL AN module (including
5 eSS EEVES the combo modules) in your purchase option, make sure that the Wireless LAN mod-
peration Aboard ) . . .
Nt uleison beforeinstalling the driver.

2MN\Z
R

e LB S Use the Fn + F11 key combination (see “ Function/Hot Key I ndicators’ on page 1
electronic transmission de-

Vel - 12) or Control Center button to toggle power to the Wireless LAN module.

A RNERCEETE] Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 3.
the module(s) are OFF if

you are using the computer

e A Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.

Use the Fn + F11 key com-
bination or hot key button to
toggle power to the WLAN
module, and check the indi-
cator to see if the module is
powered on or not (see

/

).
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There are two different drivers provided for 3rd party WLAN & Bluetooth combo
modules (one for the WLAN module and one for the WLAN & Bluetooth V4.0
combo module). The appropriate driver for your system will be installed from the
Option Driversmenu in the Device Drivers & Utilities + User’s Manual disc.

3rd Party 802.11b/g/n Driver Installation
If you see the message “Found New Hardwar e’ click Cancel to close the window.

1. Makesurethemoduleis powered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into the CD/DVD drive.

2. Click Option Drivers (button).

3. Click 2.Install WLAN Driver > Yes.

Driver Version 1 (for WLAN Modules):

4. Choose the language you prefer and click Next.
5. Click Next.

6. Click Finish to restart the computer.

Driver Version 2 (for WLAN & Bluetooth Combo V4.0):

4. Click Next.
5. Click Finish to restart the computer (see sidebar for important information).

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see page 7 - 13).

. |
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Intel® WLAN Driver Installation
If you see the message “Found New Hardwar e’ click Cancel to close the window.

1

oOUkwWN

M ake surethe moduleis powered on, and then insert the Device Drivers
& Utilities + User’s Manual disc into the DVD drive.

Click Option Drivers (button).

Click 2.Install WLAN Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click (for some driver versions you will need to select Typical or Custom)
Next/Install > Next > Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see “ Connecting to a Wireless Network in Windows 7” on page 7 - 13).

. |
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Connecting to a Wireless Network in Windows 7

Make sure the Wireless LAN module is turned on. e

1. Click the taskbar wireless icon H and then double-click an access point to con- Network and
nect to or click to Open Network and Sharing Center if you do not see a network Sharing Center
you want to connect to in the taskbar menu (a list of options will appear allowing

setting changes, and creating a new network). LSl el U e bl

work and Sharing Cen-

ter control panel in

Windows (Network and

Internet) to connect to

any available wireless
| networks.

Figure7-3
Click Taskbar Icon
Menu & Network
and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying
to connect.

3. Click to select a network location (e.g. Home, Work or Public).

4. Click “View or change settings in Network and Sharing Center” to access
further options for the connection.

Figure7-4
Network Location
Set
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5. Click the taskbar icon g to see any currently connected networks.
. . . . . | \ AL/
6. To disconnect from the wireless network you can click the taskbar wireless icon f, ﬂ:

click the active connection and then click Disconnect (button). Security Enabled

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unauthor-
ized access to your
computer, documents, web-
sites and files etc.

Figure7-5
Click Taskbar Icon
Menu - Disconnect
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Intel® My WiFi Configuration

e Intel® My WiFi Technology uses your WLAN (for Intel WLAN modules only)

Intel® My WiFi Help module to allow you to connect up to eight other WiFi enabled devices (e.g. digital
cameras, other computers, cell phones, handheld devices etc.) to your computer

To get help on Intel® & (similar to Bluetooth), while still connecting to the Internet through your WiFi wire-

My WIiFi configuration § |asg connection. Intel® My WiFi Technology offers greater range and speed than
and settings, access the

Intel® My WiFi Utility other personal area networks, and does not require an access point.
from the Start menu
(Start > Programs/All
Programs > Intel PRO-
Set Wireless > Intel My
WiFi Technology), or by
clicking the taskbar icon
. Click the Help icon
and select a
help topic from the Con-
tents menu.
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Intel® My WiFi Configuration
Y ou can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-
clicking the taskbar icon

2. Click Enable (on the first run of the program there will be no connected
devices listed).

O Figure7-6

Intel® My WiFi
Utility
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3. Click Start and click Control Panel.
4. Click Network and Sharing Center (Network and Internet).
5. Click Change adapter settings.

Figure7-7

Network and >

Sharing Center

Click Change

adapter settings
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6. Right-click Wireless Network Connection and select Properties.

Figure7-8
Network
Connections

Right-click Wireless Network
Connection and select Proper-
ties.
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7. Click Sharing (tab) and select “Allow other network users to connect through
this computer’s Internet connection”.

Select Wireless Network Connection under Home networking connection.

9. Click OK.

®

Click “Allow other network
users to connect through
this computer’s Internet
connection”.

Select Wireless Network
Figure7-9 Connection. T
Wireless Network
Connection
Properties -
Sharing

. |
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10. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All

Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-
clicking the taskbar icon
11. Click Profiles

Figure7 - 10
Intel® My WiFi
Utility - Profiles
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12. Click Profiles, click Intel Wireless PAN and click Edit or New (Note that all
preset settings may not be editable - see sidebar).

Figure7-11
Profiles

/ \
Profile Settings O O

Profiles that are preset 13. You can change the Profile Name and Network Name to your personal
may not be fully edit- preferences in General (tab).

4

Profile and Network Names

able. To edit all the
profile settings, click
New to create a new
profile and adjust the
settings to your prefer-
ences.

The Profile Name is the name as dis-
played on your computer in the Net-

work Connections control panel
(see Figure 7 - 13 on page 7 - 23).

Figure7-12 _
Intel® My WiFi The Network Name (SSID) is the

name the devices see when they try

Profile Settings -
to connect to your computer.

General
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14. Click Security (tab).
15. Change the Security Type to WEP and the Encryption Type to 64bit.
16. Enter a password (8 characters long) in the Password box.

@ =
@ =

Figure7 - 13
Intel® My WiFi

Profile Settings -
© Security
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17. Click Sharing (tab).
18. Itis recommended that the Filter Network Traffic and DHCP and DNS Server
are Disabled.

0

Figure7-14
Intel® My WiFi

Profile Settings -
Sharing

0
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19. Click Advanced (tab).
20. Itis recommended that the Default Channel is set to Channel 1, 6 or 11.
21. Click OK to save the settings.

© Figure7 - 15

Intel® My WiFi
Profile Settings -

S —— Advanced
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22. Double-click Wireless Network Connection in Network Connections.
23. Click Details to display the Network Connection Details.

Figure7- 16
Wireless Network
Connection Details

>

-
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24. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking
the taskbar icon

25. To add a new device follow the instructions in the devices’ user guide for
connecting to a WiFi network.

26. Click Add New Device in Intel® My WiFi Utility to confirm the security settings
detail.

o Figure7 - 17

Intel® My WiFi
Utility
(Add New Device)
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Intel WLAN & Bluetooth Combo Module High-Speed Data

Transfer Configuration

Y ou will need to configure the following settings to enable high-speed wireless data
transfer as supported by Intel WirelessLAN & Bluetooth Combo modules (note this
information appliesto Intel WLAN & Bluetooth Combo modules only).

1. Go the Windows control panel and double-click Device Manager (in Hardware
and Sound under Devices and Printers).

S—

Figure7-18
Devices and
Printers
(Device Manager)

. |
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Click Network adapters to expand the sub-menu.
Double-click the Intel WiFi Link .... module.
Click Advanced (tab).

Click 802.11n Channel Width for band 2.4 under “Property:”.

Click the pull-down menu under “Value:”
Click to select Auto.
Click OK and close the control panels.

-

Modules & Options

>

D

Figure7-19
Intel WiFi Link
Properties
(Advanced)
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Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control
Panel).

2. Double-click Windows Mobility Center (Mobile PC).

3. Click the button to Turn wireless off/on, or click the icon .l to access the network
menu.

Figure7- 20
Windows Mobility
Center

7 - 30 Wireless LAN Module



Modules & Options

3G Module

(For ModelsA & C Only) 4

If you have included an optional (for Models A & C Only) UMTS/HSPDA OR 3G Module Options
UMTS/H_SPDA+ based 3G Module (Universal Mobile Tel_eco_mmunications VS | there are two optional
tem or High Speed Packet Access) module (see “ Communication” on pageD -5 | 3.6 modules available for
for specification details) in your purchase option, you will have the appropriate ap- | this series of computer
plication (Wireless Manager or AirCard Watcher) provided for your particular ';:f;ﬁji':a vfl?ﬁrlh:"gg::ipr'f
module. Follow the instructions on page 7 - 32 to install the USIM card (which will | ate application software.

be provided by your service provider), and then install the application

The module type supplied
may depend upon the com-
puter model purchased.
Check with your distributor/
supplier for details.

2N\Z
A

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 3G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.

3G Module Power

Install the driver from the
Drivers Installer menu and
check the instructions for
the appropriate application
on the following pages.

Note that when the computer resumes from a power saving state, is restarted or starts up
after shutdown, the 3G module will be powered off.
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3G Module USIM Card Installation
L Follow the instructions below to install the USIM card (which will be provided by
Power Safety your service provider).
Warning

Turn off the computer, and turn it over.
Slide the latch @ in the direction of the arrow.
Slide the latch @ in the direction of the arrow, and hold it in place.

Before you undertake any
installation procedures,

make sure that you have
turned off the power, and Remove the battery‘

disconnected all peripher- Insert the USIM card (at the rear of the battery compartment) as illustrated below
als and cables (including until it clicks fully into position, and replace the battery.

telephone lines). It is advis-

able to also remove your

battery in order to prevent G

accidentally turning the ma- 9

chine on.

arNE

USIM Card Orientation

Note that the USIM card’s
readable side (with the
gold-colored contacts)
should face upwards as il-
lustrated.

Figure7-21
Battery Removal &
USIM Card Insertion
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Beforeinstalling theapplication, makesurethat the 3G moduleisON (installing

the driver with the module off will not allow the software to detect the modul e hard- 4
ware correctly). UsetheFn +  key combination (see Table 1 - 4, on page 1 - 12) 3G Modules &
or Control Center button to toggle power to the 3G module. Make sure you install System Wake Up

the driversin the order indicated in Table 4 - 1, on page 4 - 3. Note that exiting the

application does NOT turn off the 3G module. Note that the 3G modules

DO NOT support system

: . k 3G mod
* WirelessManager - See“ Wireless Manager Installation” on page 7 - 34 for \;V;iﬁtylfp on =% modem

driver installation information and “ Wireless Manager Application” on page 7
- 35 for instructions on using Wireless M anager .

* AirCard Watcher - See“ Sierra Wireless AirCard Watcher Installation” on
page 7 - 56 for driver installation information and “ AirCard Watcher Applica-
tion” on page 7 - 57 for instructions on using Air Card Watcher.

. |
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Wireless Manager
\ A/

L& With the 3G module and USIM card (supplied by your service provider) installed
Wireless Device you may then install the Wireless Manager application. The Wireless Manager

Operation Aboard application alows you to directly access your HSPA internet service from the com-
Aircraft puter.

The use of any portable . :
S | Wireless Manager Installation

vices aboard aircraft is usu- : . . .
eSS +
ally prohibited. Make sure 1. Enable power to the module by pressing the Fn key combination (give

the module(s) are OFF if the module about 10 seconds to power on).

yf;“ arde U_Singf:he sl 2. If aFound New Hardware window appears, click Cancel (click Cancel for
SREE SR al Found New Hardware windows that appear).

Insert the Device Drivers & Utilities + User’s Manual disc into your DVD
drive.

Click Option Drivers (button).

Use the Fn + . key com-
bination to toggle power to
the 3G module, and check
the indicator to see if the

3
4.
module is powered on or 5. C“Ck 5.1 nSta” 3G Drive’ >Yes.
6
7
8

Click Next > Next > Install.
Click Finish.
Access the Wireless Manager application from the Start menu or the desk-

top shortcut

not (see
/

).

. |
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Wireless Manager Application

The connection information is stored on the USIM card supplied by the service pro- e
vider (where thisis not the case you may need to create a profile - see “ Creating a PIN Number
Profile’ on page 7 - 41).

The PIN number for

1. Power on the 3G module using the Fn + key combination. your USIM card will be
2. Access the Wireless Manager application from the Start menu (Start > All supplied by your service
Programs > Wireless Manager > Wireless Manager) or the desktop shortcut . provider. You usually
3. You may be required to enter you PIN number and click OK. have a limited number of
4. Click the Connect [ Connect | button (a Profile needs to be selected, and in attempts to enter the
most cases this will be pre-configured). correct PIN number.

If you fail to enter the
PIN number correctly
you will be blocked from
accessing the USIM
card and you will need a
PUK (Personal Un-
blocking Key), supplied
by your service provider,
to unlock it.

Figure7 - 22
Wireless Manager
(Not connected)
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5. The system will connect to your network.

6. Connected will appear above the timer icon (the timer will indicate your connected
time for the current session) ¢ meems -

Wireless Manager 7. You can then access the internet, download e-mail etc. as per any internet

Help connection.

To get help on Wireless
Manager configuration

and settings, click the
Help icon or press F1.

€9 Help

Figure7 - 23
Wireless Manager
(Connected)
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8. Click the Wireless Manager notification area iconﬂ to view the connection status,

or wireless iconjff] to view the Mobile Broadband Connection status.

Figure7-24
Notification Area
Icons (Connected)

0 5 -

Notification Area

9. Theindicator _gll__ Wil display the signal strength and radio access Icon
technology. UmMTS : . —
10. To disconnect from the service provider, click the Disconnect [ pienes | button Right-click the notification

area icon to bring up the
menu to Open/Exit Wire-
less Manager, Discon-
nect or Turn radio off.

(note that if you click the close icon at the top right of the screen the application will
minimize to the system tray, however the application will still be running; to exit the
application right-click the natification area icon and click Disconnect or Exit
Wireless Manager).

11. The program will disconnect from the service provider.

12. The module will still be on, and you will need to press the Fn + key combination
to turn it off.

13. If you are unsuccessful in connecting this way you may need to add a profile with
information provided by your service provider (see the following pages).
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Profiles

1. Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click the Settings > Advanced.

3. Click the Profiles (tab).

Figure7 - 25
Advanced Settings -
Profiles

. |
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4. Multiple profiles may be available from the USIM card and the first time the
application starts it may require you to select a profile (Set Profile) to use for your
connection.

Multiple Profiles Found

Multiple profiles were found for this 3IM card. From
the list below, please select which profile to use for
connecticn.

Figure7 - 26
Multiple Profiles
Found

( Set Profile |

Automatic Profile Selection

If Automatic selection is chosen, then the application will search the operator pro-
file database for a profile that matches the details on your USIM card. If a correct
profileisfound it will be automatically selected as your profile.

Manual Profile Selection

If Manual selection is chosen, then you can select a profile from the applications’'s
operator profile database, or you can create a new profile.
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Selecting a Profile

1. Click Manual selection (button).
2. Click the Filter to view the drop-down list.
3. Select the Profile you wish to use and click Apply to confirm the selection.

Figure7 - 27
Profile - Manual
Selection (Filter)

. |
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Creating a Profile

1. Click Manual selection (button). /

2. Click the New.

3. Enter a name you prefer for the profile. Deleting a Profile

4. Enter the Access Point Name (APN). Toldeleteraipionletcliek

5. Enter the User Name and Password if required (some service providers may not to select Manual selec-
require this information and the fields may then be left blank). tion and select the pro-

6. If your service provider requires IP address, DNS and Protocols to be entered, file and click Delete.
click the appropriate tab and enter the supplied information (otherwise leave blank).

7. Click Save to save the profile information.

Modifying a Profile

8. The profile will be stored under User defined in the Filter drop-down list.
To modify a profile click
to select Manual selec-
tion and select the pro-
file and click Edit.
Change the settings as
required and then click
Save (note that only
user defined profiles
may be edited).

Figure7 - 28
New Profile IP, DNS
& Protocols
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Figure7 - 29
Settings

Settings

The Settings tab allows you at adjust the application features. Click to put atick in
Launch Wireless M anager at Windows star tup to launch the application at Win-
dows Startup.

The Advanced settings allows more detailed configuration. To access the Ad-
vanced settings.

1. Access the Wireless Manager program from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click the Settings > Advanced.

3. Click the tab to edit any particular setting.
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SIM
Most USIM cards are protected by a Personal Identity Number (PIN). Y ou may turn 4
on or off the Request PIN at startup (click Apply to save any changes). You can

aso Change PIN (you will need to enter the new PIN in the two fields provided and PIN'Notes

click Apply to save any changes). You will have to enter
_ your current PIN to

Radio change the PIN settings.

Radio needs to be turned on before you can make any connection (note thisis not

. . . . Request PIN at startup
the same as powering the module off/on using the Fn +  key combination), but & & e g ey
you may turn it off when required. Automatic modeis the recommended setting for | have shut the computer
most 3G networks as it will use 3G where available. All Frequency bandsarese- | down and restarted it
lected as default (click Apply to save any changes). (not just restarted).

Radio & Power
Saving States

You can choose to have
the radio turned on or off
during Hibernate or
Sleep power saving
states.

Figure7 - 30
Advanced Settings
SIM & Radio
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Networks
L6 The mobile network list lists available networks at your location, and allows you to
Warning select a network which to connect. Y ou must disconnect before being able to select
Note that some applica- anetwork.
tions automatically Connection

transmit data when con- . .
b e Al You can set the Wireless Manager to automatically connect at Windows startup

e EEGEEER  (however the module must be powered on, and radio must be turned on). Y ou can
LEUSIEE SR RIORE gl so automatically connect when resuming from a power-saving state (click Apply
(Rl ST to save any changes). Click Default to return to the original default settings.

settings may lead to ex-
pensive roaming charg-
es.

Figure7 - 31
Advanced Settings
Networks &
Connection
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Text Messaging Service (SMS)

In addition to standard internet services you may also send and receive SMS text
messages using the Wireless Manager, if your service supports SMS.

SMS Utility

1. Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click SMS and the SMS Utility will then start.

3. The indicator in the upper right corner will display if radio is currently on or off
(radio must be on in order to send/receive messages).

Figure7 - 32
SMS Utility Open
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Messages
Click the M essages tab to access the tabs displaying text messages. The tabs at the
top of the menu display the Inbox, Drafts, Outbox, Sent and Trash menus.

Inbox Drafts Outbox Sent Trash

Figure7 - 33
SMS Utility
Messages

Text messages are automatically saved to your computer and may be sorted in as-
cending or descending order by name or date.
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Sending a Text Message

1. Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut

2. Click SMS and the SMS Utility will then start.

Click the New Message tab.

4. Enter the phone number in the To field (multiple numbers may be entered
separated by a semicolon (;), or click the phonebook icon i to select a name from
the phonebook.

5. Select any contact’s phone number and click OK (you can click a check box to
select multiple contacts or more than one phone number for each contact).

6. Type the message body in the Message field (to a maximum of 160 characters).

w

Figure7- 34
SMS Utility - New
Message
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Figure7 - 35
SMS Utility - Inbox &
New Message
Received
Notification

7. Click Send [z send |to send the message or Save [ [ sa= | t0 save the message in

the Drafts folder. o

Clicking the Clear icon | & Ceat | clears both the Message and To fields.

9. Ifradio is on then the message will be sent, however if the radio is off the
message will be stored in the Outbox.

@

Note that you do not have to connect to the network to Send/Receive SM S mes-
sages.

Inbox

Any received text messages will be displayed in the Inbox. The number of unread
messages will be displayed in parenthesis in the inbox tab. Unread messages will be
displayed in a darker color then the read messages, and incoming messages will be
displayed briefly in the Notification Area.
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Messages
* Opening a text message: Double-click the message and the message will open
in anew window (to closeit click the close icon in the top right of the message).

Figure7 - 36
O4_/_Click to close the message Close Message

* Previewing atext message: Click the preview icon (& and the message preview
will open. Click the icon again to close the preview.

* Replyingto atext message: Double-click the message and click Reply. Type
the reply in the message field and click Send to send the message (or Save to
saveitin Drafts.

» Forwarding a text message: Double-click the message and click Forward.
Type the recipients namein the To field or click the icon i to select recipients
from the phonebook.

» Deleting a text message: Right-click the message select Delete selected. To
delete a messages in the folder right-click any message and select Delete All.
Holding down the Ctrl key and selecting messages allows you to multiple select
messages for deletion (choose Delete selected). Deleted message will be sent to
the Trash folder. To permanently delete messages right-click and select Delete
selected or Delete All (or you may choose to Recover/Recover All) and click
Yes to confirm.

. |
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Phonebook

The Phonebook allows you to view and edit all your frequently used contacts, and
is divided into Contacts f§j and Groups iﬁ To access the Phonebook:

1.

2.
3.

Figure7 - 37
SMS Utility -
Phonebook

(Contacts)

Access the Wireless Manager application from the Start menu (Start > All Pro-
grams > Wireless Manager > Wireless Manager) or the desktop shortcut
Click SMS and the SMS Utility will then start.

Click the Phonebook tab.
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New Contact: Click the New contact button [ & Newcontact.. | to create a contact.
Add the name and at least one phone number (M obile, Work, Home and Other
fields are available) for the contact. Click the &) icon to expand the number
details. Select Synchronize with SIM to synchronize the contact information

with your USIM card. Click the Saveicon [] to save the information.

Edit Contact: Click the edit icon ¢ to make changes to a contact detail, and
click save 5] to confirm the changes.

Delete Contact: Click the deleteicon [l to delete a contact from the phone-
book.
Send a message to a Contact: Click the message icon ] to send atext mes-

sage to any contact.

Modules & Options

4

Import/Export
Contacts

Import/Export Con-
tacts: Click the Import/
EXport |: Import.. | I: Export... |
buttons to import or ex-
port the list of contacts.

Figure7 - 38
SMS Utility
New Contact
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Figure7- 39
SMS Utility
Groups
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Groups
Y ou can organize existing contacts into groups from the Groups tab.

« New Group: Click the New group button (& Newgreup..| to create agroup. Click
the (&) icon to expand the group details, and click acheck box to add at least one

phone number from the contacts for the group. Click the Save icon [£] to save
the information.

« Edit Group: Click the edit icon ¢ to make changesto a contact detail, and click
save 5] to confirm the changes, or close g3 to exit without making changes.
+ Delete Group: Click the delete icon [ to delete a group from the phonebook.

» Send amessage to a Group: Click the message icon [ to send a text message
to any group.
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SMS Settings
The SMS Utility Settingstab allows you at adjust the SM S features.

Figure7 - 40
SMS Utility Settings

4

SMS Settings

Message Length: You can
set the number of blocks
that can be sent (up to a
length of 10 blocks).

Message validity period:
This sets the period after
which the message will be
deleted from the SMS cen-
ter and therefore not for-

The Advanced settings allows more detailed configuration. To access the Ad-

vanced settings: warded to the recipient(s)
when they come online.

1. Access the Wireless Manager application from the Start menu (Start > All Pro- Display information mes-

grams > Wireless Manager > Wireless Manager) or the desktop shortcut . sages: You can choose

2. Click SMS and the SMS Utility will then start. whether to allow informa-

3. Click the Settings > Advanced. s e

. . ; . [
4. Click the tab to edit any particular setting. Ezt.y Rl S B
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Send

Click Delivery Report to automatically request areply from arecipient. If you click
to Send messagesin Outbox automatically upon connection then messages writ-
ten when theradio is off, will then be sent automatically the next timeradio isturned
on. You can also choose to I nclude original messagein reply.

Notification

Thismenu allows you to enable/disable Show animation on new messageto get an
animated notification of newly received messages. Enabling Play sound on new
message will play an audio notification upon receipt of new messages.

Figure7-41
SMS Utility -
Advanced Settings
Send & Notification

. |
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Number

Y ou can choose to Use default service center number or you can uncheck the box
and add your number manually if your service provider supplies a different number
(click Apply to save the change or Default to return to the default number).

Memory
Phonebook memory status displays the number of contacts displayed on the USIM
card.

Figure7 - 42
SMS Utility -
Advanced Settings
Number & Memory

. |
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N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + . key com-
bination to toggle power to
the 3G module, and check
the indicator to see if the
module is powered on or
not (see

/

).
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Sierra Wireless AirCard Watcher

With the 3G module and USIM card (supplied by your service provider) installed
you may then install the Sierra Wireless AirCard Watcher application. AirCard
Watcher allows you to directly access your internet service from the computer.

Sierra Wireless AirCard Watcher Installation

1. Enable power to the module by pressingthe Fn +  key combination or
Control Center button (give the module about 10 seconds to power on).

2. If aFound New Hardware window appears, click Cancel (click Cancel for
all Found New Hardware windows that appear).

3. Insert the Device Drivers & Utilities + User’s Manual disc into your DVD
drive.

4. Click Option Drivers (button).

5. Click 5.Install 3G Driver > Yes.

6. Click Next > Install > Finish > Next > Finish.

7. Thehardware driver installation is now complete so select “ No, | will
restart my computer later” and click Finish (do not restart the computer).

8. Another window will now pop up to install the Air Card Watcher applica
tion.

9. Click Next, click the button to accept the license agreement and click Next.

10. Click Finish.

11. The Air Card Watcher application will now run, or you can click the desk-
top shortcut ~ or run it from the Sierra Wirelessitem in the Start menu.
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AirCard Watcher Application

The connection information is stored on the USIM card supplied by the service pro- e
vider (wherethisis not the case you may need to create aprofile - see” Profiles’ on PIN Number
page 7 - 63).
The PIN number for
1. Power on the 3G module using the Fn + key combination. your USIM card will be
2. Access the AirCard Watcher application from the Start menu (Start > All supplied by your service
Programs > Sierra Wireless > AirCard Watcher) or the desktop shortcut . provider. You usually
3. Ifyou need to set up a network operator (see page 7 - 62). have a limited number of
4. Click the Connect button (a Profile needs to be selected, and in most attempts to enter the
cases this will be pre-configured). correct PIN number.

If you fail to enter the
PIN number correctly
you will be blocked from
accessing the USIM
card and you will need a
PUK (Personal Un-
blocking Key), supplied
by your service provider,
to unlock it.

Figure7 - 43
AirCard Watcher
(Not connected)
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5. The system will connect to your network.
/ 6. The iconIEWiII turn greenf (and the upload/download speeds will be indicated).
7. You can theh access the internet, download e-mail etc. as per any internet
AirCard Watcher connection.

Help Topics

To get help on AirCard
Watcher configuration
and settings, click the
Menu icon and select
Help Topics.

Always |

Help Topics

Figure7- 44
AirCard Watcher
(Connected)
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8. When connected the uplink/downlink speeds will be indicated.

9. You can also click the Speed Graph icon to get a visual display of the uplink/ /
downlink speeds.

10. While connected you can also click the icon I in the notification area of the Roaming
taskbar to display the Windows 7 Mobile Broadband connection status. Notification

AirCard Watcher will
provide notification

when you connect to a
network other than your
service provider. This
can be turned on/off
from User Options >
General > Warning
Messages.

Figure7 - 45
AirCard Watcher
with Speed Graph
(Connected)
&
Taskbar Menu
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11. To disconnect from the service provider, click the Disconnect button
/ . (note that if you click the close [x] icon at the top right of the screen the application
will close however the connection will still be maintained).
Online Help 12. You can also click the icon n in the notification area of the taskbar to display the

connection status, click Connected, and then click the Disconnect button.
. The program will disconnect from the service provider.
14. The module will still be on, and you will need to press the Fn + key combination
to turn it off.

Click the Online Help 13

icon to access the
Sierra Wireless website
for further help if re-
quired.

Figure7 - 46
AirCard Watcher
Disconnect
&
Taskbar Menu
Disconnect
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Air Card Watcher Menu
Right-click the menu [&]| button at the top of the Air Card Watcher screen to bring 4
up the menu, and click to select any item required.

Airplane Mode

Click on the Airplane
Mode icon to turn the ra-
dio power off (e.g. if you
are aboard an aircraft).
You can turn the radio
on again by clicking the
Turn Radio On button.

Figure7 - 47
AirCard Watcher
Menu

. |
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4

Network Operator

If the network operator
is not listed then choose
Generic UTMS.

Figure7 - 48
Options - Firmware
(Network Operator)

Selecting a Network Operator/Service Provider

In most cases all your network operator/service provider details will be stored on
your USIM card, and will not need to be edited/modified. If you do need to set up a
network operator/service provider follow these instructions.

1.

2.

Eal

Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

Either click the menu [&] button and select Options, or click the Options button
from the main program window.

Click Firmware.

Click to select a Network Operator from the dropdown menu.

Click OK.
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Profiles

A profile containsinformation used to establish a data connection, and thisinforma-
tionisusually stored on the USIM card supplied by your service provider. However
you can create, edit or delete profilesif required.

Creating a Profile

1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Make sure you are not connected to a network.

3. Either click the menu [=] button and select Connections, or click the Connections
button - from the main program window.

4. Click Profiles and click the Add new profile button and select Custom.

Figure7 - 49
Options - Profile

Add new profile
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5.  You will need to complete the fields for Profile name, Username, Password and

/ 3 Access Point Name (you will need to get the username and password details from
your service provider).
Edit or Delete 6. Once you have added the details above you can click the Profiles heading menu
Profiles and click to select the profile from the Selected Profile dropdown menu and then

Select anv existing bro- click OK to set the profile as the default connection.
files to egit or delgetg it 7. Select the profile and click Advanced to set the Autolaunch, TCP/IP and DNS
el Tan ek GI% tc; settings (check with your service provider for any specific requirements in these

confirm any changes fields).
made.

You can also change the
default profile from the
dropdown menu and then
click OK to confirm the
changes.

Figure 7 - 50
Profile - Advanced
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User Options
Y ou can configure User Options as follows.

1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Either click the menu [E] button and select Options, or click the Options button
from the main program window.

3. Click on any of the menu headings on the left to access the options that may be
configured (note that not all options will be available to be configured as they may
depend on your USIM card settings).

Figure7-51
User Options
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General - Thisitem allowsyou to set options for Sartup/Shutdown, War ning
M essages, Display and Windows support.

M essaging - Set options here for SM S settings.

Network - Configure the network settings from this menu though your fre-
quency band information is usually stored on the USIM card.

SIM Settings - You can set your SIM Security and PIN # options here.

Sounds - This alows you to set sounds applicable to certain application actions
e.g. when anew SMS arrives.

Profiles - Create, edit, delete and set the default profile from the items here.

Data Useage Tracking - You can enable/disable data tracking e.g. for billing
purposes.

Firmware - If you need to change network operator/service provider you can do
so here.
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Text Messaging Service (SMS)

In addition to standard internet services you may also send and receive SMS text
messages using Air Card Watcher, if your service supports SMS.

SMS Express

1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

2. Either click the menu [2] button and select SMS Express, or click the SMS
Express button n from the main program window.

Figure7 - 52
SMS Utility Open
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Sending a Text Message
/ 1. Access the AirCard Watcher application from the Start menu (Start > All Pro-
grams > Sierra Wireless > AirCard Watcher) or the desktop shortcut

S MESsEEES 2. Either click the menu |[=/ button and select SMS Express, or click the SMS

Sent messages will be Express button g from the main program window.
automatically saved to 3. Select File > New Message or click the New button in the toolbar.
the Sent Items folder. 4. Type the recipients phone number in the “To:” field (to send to multiple recipients

separate the numbers using a semi-colon or space).
Type the message (160 characters max) in the bottom part of the Message window.
6. Click the Send button or Save the message to send/edit later.

o

Figure7 - 53
Profile - Advanced

Note that you do not have to connect to the network to Send/Receive SM S mes-
sages aslong asthe moduleison.
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Inbox

Any received text messageswill be displayed in the I nbox. The number of total mes-
sages and unread messages will be displayed in the inbox folder title.

M essages

» Opening a text message: Click on any message in the Inbox to read it in the
bottom panel of the window.

* Replyingto atext message: Click on any message in the Inbox and select
Actions > Reply or click the Reply button in the toolbar. Type the reply in the
message field and click Send to send the message (or Save to saveit in Drafts).

» Forwarding atext message: Click on any message in the appropriate folder
and select Actions > Forward or click the Forward button in the toolbar. Enter
the recipient’s phone number in the “To:” field and make any additions/changes
required in the message field and click Send to send the message (or Save to
saveit in Drafts).

» Deleting a text message: Click on any message in the appropriate folder and
select Actions > Delete or click the Delete button in the toolbar. Click Yesto
confirm the deletion.

. |
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Bluetooth & WLAN Combo Module

If your purchase option includes the Combination Wireless LAN & Bluetooth
module (either Intel® or 3rd Party) then install the driver as instructed overleaf.

\ 7/
L&
Wireless Device

Operation Aboard

Aircraft Use the Fn + F12 key combination (see Table 1 - 4, on page 1 - 12) or Control

The use of any portable Center button to toggle power to the Bluetooth module.
electronic transmission de-
4

vices aboard aircraft is usu-
ally prohibited. Make sure
Bluetooth Data Transfer

the module(s) are OFF if

you are using the computer
aboard aircraft.

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in

one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-

ered on or not (see » For 3rd party Bluetooth modules see the installation procedure see “ 3rd Party
)’ Bluetooth (V4.0) Combo Driver Installation” on page 7 - 71 and “ Standard
' Bluetooth Configuration in Windows 7’ on page 7 - 73.

» For Intel Bluetooth modules see the installation procedure see “ I ntel Blue-
tooth Combo Driver Installation” on page 7 - 72 and “ Standard Bluetooth
Configuration in Windows 7" on page 7 - 73.
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3rd Party Bluetooth (V4.0) Combo Driver Installation

1. Beforeinstallingthedriver make suretheBluetooth moduleispowered

on (use Fn + F12 key combination), then insert the Device Drivers & Utili-

ties+ User’'s Manual disc into the CD/DVD drive. If aFound New Hard-

ware window appears, click Cancel in all windows that appear, and then

proceed to install the driver as below.

Click Option Drivers (button).

Click 4.Install Combo BT Driver > Yes.

Click Next (if aprompt appearsto ask you to turn the Bluetooth power on,

pressthe Fn + F12 key combination to do so, otherwise the driver will not

be installed).

5. Click Finish to restart the computer.

6. See® Standard Bluetooth Configuration in Windows 7” on page 7 - 73 for
configuration instructions.

pWON

. |
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Intel Bluetooth Combo Driver Installation

4 1. Beforeinstallingthedriver make surethe Bluetooth moduleis powered
High Speed Bluetooth on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
Data Transfer ties + User’'s Manual disc into the CD/DVD drive. If aFound New Hard-
The Combination Wire- ware window appears, click Cancel in all windows that appear, and then
less LAN & Bluetooth proceed to install the driver as below.

module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

Click Option Drivers (button).

Click 4.Install Combo BT Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.
Click Next > Finish.

See over for configuration instructions.

NoakrwN

To obtain high speed
data transfer make sure | Notethat, at the time of going to press, Intel® Centrino® Wireless-N 2230 and I n-

that both the WLANand | tel® Centrino Advanced 6235 & Bluetooth combo modules use the standard Blue-
Bluetooth modules are § 1,1y configuration in Windows 7 (see “Standard Bluetooth Configuration in

poweredon. Windows 7" on page 7 - 73).
Check your Bluetooth

compatible device’'s doc-

umentation to confirm it

supports high speed data

transfer.
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Standard Bluetooth Configuration in Windows 7
For Intel and 3rd Party Driver Version 2 (Bluetooth V4.0) modules only.

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On

1. Pressthe Fn + F12 key combination to power on the Bluetooth module.

2. A Bluetooth icon  will appear in the taskbar.

3. You can then do any of the following to access the Bluetooth Devices control
panel.

» Double-click the taskbar icon  to access the Bluetooth Devices control panel.

* Click/Right-click the taskbar icon and choose an option from the menu.

Add a device

Right-Click Taskbar Icon

Bluetooth & WLAN Combo Module 7 - 73
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4

Add a Device

Click Start, and click Con-
trol Panel and then click
Devices and Printers
(Hardware and Sound).
Click Add a device to
search for any available
Bluetooth devices.

Bluetooth Module &
Resuming From Sleep
Mode

The Bluetooth module’s de-
fault state will be off after
resuming from the Sleep
power-saving state. Use
the key combination (Fn +
F12) to power on the Blue-
tooth module after the com-
puter resumes from Sleep.

Figure7 - 54
Bluetooth Devices &
Click Icon Menu
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To Add a Bluetooth Device

/ 1 1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure7 - 55

Add a Device ] ) ) ) ) B
3. Onfirst connection the computer will provide you with a pairing code to be entered

onto the device.
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

4

- Figure7 - 56
Pairing Codes

Pairing Code
The example outlined here shows a connection to Example

a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing.

6. Follow any on-screen instructions on the computer if device drivers are required to
be installed.

7. Click Close.

Figure7 - 57
Pairing Complete &
Bluetooth Device
Enabled
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To Change Settings for the Bluetooth Device
/ 1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:

* Change the name of the device (click Bluetooth, type a new name and click OK).
« Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

To get help on Bluetooth

configuration - and - set- | T4 \ake your Computer Discoverable to Bluetooth Devices
tings, select Help and

Support from the Start 1. Cl!ck the 'Faskbar icon and select Open Settings. _ _ _
menu. Type Bluetooth in 2. Click Options, and make sure that Allow Bluetooth devices to find this

the Search Help box, and computer check box (Discovery) has a tick inside it.
select an item from the re- 3. Make sure that the Alert me when a new Bluetooth device wants to connect
turned search results to check box (Connections) has a tick inside it, if you want to be notified when a
get more information. Bluetooth device wants to connect.
Figure7 - 58
Bluetooth Settings -
Options
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Intel Rapid Storage Technology

Install the Intel Rapid Storage Technology to support your SATA driveif set up in
AHCI modeinthe BIOS (see “ SATA Mode (Advanced Menu)” on page5 - 9).

IRST Driver Installation

1

HON

o

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 5.Install IRST Driver > Yes.

Click (click the button to “Install Intele Control Center”) Next > Yes >

Next > Next.
Click Finish to restart the computer (you will need to restart the system
again after the computer has rebooted).

* Thelntel® Control Center providesacentral starting point for Intel applications
tomakeit easier to find programs required. Accessthe Intel® Control Center from
the Start > All Programs > Intel > Intel® Control Center.
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THX TruStudio Pro Audio

Install the THX TruStudio AP to allow you to configure the audio settings to your
requirements for the best performance in games, music and movies.

THX TruStudio &

S CEUGH
Configuration

THX TruStudio AP Installation

LSS 1 Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
abled when you are DVD drive.

connecting to an exter- Click Option Drivers (button).

nal display through an Click 6.Install THX TruStudio AP > Yes.
HDMEConnEction. Choose the language you prefer and click Next.
Click Yesto accept the license.

Click Next.

Click Full Installation (button).

Click Next > Finish to restart the computer.

ONOUAWDN
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THX TruStudio Pro Activation ™
On thefirst run of THX TruStudio Pro you will need to activate the application. L&

THX Audio & HDMI

1. To activate the application you will need to be connected to the internet.

2. Double-click the THX Activate icon on the desktop and click the Activate Note that the THX audio

button. effects do not apply to
3. The program will connect to the internet to verify the activation key. audio generated
4, Click Finish to complete the application activation. through an HDMI con-

5. Restart the computer after the process is complete. nection.

THX TruStudio Pro Application

The application can be run from the shortcut in the Start menu (Start > All Pro-
grams >Creative> THX TruStudio Pro Settings).

Power On/Off —#

Figure7 - 59
THX TruStudio Pro
Menu

Collapse/Expand View
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THX Control Panel

Each control has an On/Off button to alow you to enable/disable the control, and
most controls feature a slider to adjust the levels (the subwoofer may be turned on/
off).

Figure7 - 60
THX TruStudio Pro
Controls

» Surround: Provides virtual sound channelsto control the level of immersion.

* Crystalizer: Enhances audio to make it sound livelier.

» Speaker: Enhances the bass level of the sound system.

* Smart Volume: Minimizes sudden volume changes to avoid the need for con-
stant adjustment.

» Dialog Plus: Enhances dialogue levels for movies etc.
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THX TruStudio Pro Headphone Settings

THX TruStudio selects the built-in speakers by default and this setting may cause
some sound quality issueswhen using headphones. To adjust the settingsfor head-
phones do the following:

1. Runthe THX TruStudio Pro application.
2. Select Settings from the menu.
Figure7 - 61
THX TruStudio Pro
Settings
3. Select Headphones from the drop-down menu (you can adjust the slider for
crossover frequency).

4. Click OK and close the application.

Figure7 - 62
THX TruStudio Pro
Select Headphones
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THX TruStudio Pro & HDMI
1. When you connect an HDMI display to the HDMI-Out port, the THX Tru Studio Pro
controls will be disabled.

2. A warning box will pop-up and will prompt “Do you want to select another audio
device now?”.

3. Click No to continue using the HDMI audio output from your external display (do
not attempt to select another audio device when connected to the external HDMI
display).

Figure7 - 63

THX TruStudio Pro
7 HDMI Display
Warning

O
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Intel® Smart Connect Technology

Intel® Smart Connect Technology periodically, and briefly, wakes the computer
from Sleep mode in order to update information for certain applications (e.g. to get
mail from Microsoft Outlook) as required. These updates can therefore be made
without having to turn the computer on, and applicationswill be up to date when the
computer resumes from Sleep mode (make sure that I ntel Smart Connect Technol-
ogy is enabled in the BIOS - see “Intel Smart Connect Technology (Advanced
Menu)” on page5 - 8).

Notethat the applications need to be on and running when the computer enters
Sleep mode in order to get updates.

Intel Smart Connect Technology Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 7.Install ISCT Driver > Yes.

Click Next.

Click the button to accept the license agreement and click Next.

Click Next > Install > Finish.

Click Yesto restart the compuiter.

No arMLON

.|
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Intel® Smart Connect Technology Configuration

\ A/
7£l< 1. Access the Intel(R) Smart Connect Technology application from the Start menu.
Wireless Device 2. Click Basic (tab) and adjust the slider to set the update frequency (note that the
Operation Aboard slider balances between “More Frequent Updates” and “More Battery Life”).
Aircraft 3. Note the sidebar warning about the use of Intel(R) Smart Connect Technology
aboard aircraft and make sure your wireless LAN module is off during air travel.
The use of any portable 4. In order to update any applications, they will need to be on and running when the

electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

computer enters Sleep mode.

you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

/

).

Figure7 - 64
iSCT Basic
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o

Click Advanced (tab) to access the Extended Power Savings settings.

6. Extended Power Savings allows you to set a time period during which the
computer will update less often (e.g. at night while you are asleep or whenever you
are at work).

Figure7 - 65
iSCT Advanced

7. Updates set during this time period will be performed every two hours, and this will
override the settings selected in the Basic tab in order to conserve power
consumption.
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8. Click the Help tab and click Topics to access the main Help menu.

4

Intel WLAN Modules

If your purchase option
includes an Intel WLAN
module, (with Intel's
PROSet Wireless Con-
nection  Utility in-
stalled), Intel® Smart Q
Connect Technology
will search for WiFi net-
works around you that

you have previously ac-
cessed.

If no known WiFi net-
works are found, your
computer will not update
again until it recognizes
a known WiFi network.

Figure7 - 66
iSCT Help
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Intel® Wireless Display Application

The Intel® Wireless Display Application (requires Intel® Centrino WLAN/ /_
Combo module), in conjunction with acompatible video adapter (purchased sep- Compatible
arately), allows you to display the contents of the notebook display on another dis- Adapters

play (e.9. HDTV) without the need to have cables stretching acrossaroom. Youcan | For a list of compatible
then play games, browse the internet, display videos or photo slide shows on your | display and audio adapt-
TV/external display without using HDMI or A/V cables. ers check the Intel web-

site, or your distributor/

lier.
Before configuring the Intel® WiDi application you will need to set up your com- SHPPIET

patible adapter with your display/speakers. Connect the adapter using an HDMI or
A/V cable and turn on the display (or in the case of speakers connect them to the
wireless speaker adapter with the cables provided with the adapter), and then set the
display to the appropriate input channel (see the documentation supplied with your
compatible adapter for full details).

Intel® WiDi aso incorporates I ntel® Wireless Music which allows you to wire-
lessly stream audio from your computer to speakers connected to a compatible
wireless speaker adapter (purchased separately).
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Intel® WiDi Application Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 8.Install WiDi AP > Yes.

Click Next.

Click the button to accept the license and click Next.

Click Finish.

Intel® Wireless Music Driver Installation

If you wish to use your system to stream wireless audio to speakers connected to a
compatible wireless speaker adapter you will need to install the Intel(R) Wireless
Music Driver.

OOk wWN

1. Insert the Device Drivers & Utilities + Usar’s Manual disc into the CD/

DVD drive.

2. Click Browse and browse to the driver location (X: denotes your DVD
drive):

o X:\Options\02WL AN\Intel_WM usic\autorun.exe

3. Click Next.

4. Click the button to accept the license and click Next.

5. Click Finish.

6. Follow the procedure overleaf to setup WiDi or Wireless Music.

.|
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Intel® WiDi Application Configuration

1. Click Start > All Programs > Intel Corporation > Intel(R) Wireless Display >
Intel(R) Wireless Display, or double click the icon on the desktop.

2. Click I agree to the terms of this license (button).

3. The application will scan for any connected compatible adapters (or you can click
the Scan for available adapters button to enable Intel My WiFi Technology).

Figure7 - 67 7
Intel® WiDi Scan
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Click to select and detected adapters, and click Connect.

The system will then prompt you to enter the 4-digit security code which will be
displayed on the external TV Screen (or press the connect button on the wireless
speaker adapter).

6. Enter the code for the video adapter and click Continue.

ok

Figure7 - 68
Intel® WiDi Connect
& Enter Security
Code

.|
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7. You will then be prompted to enter a name for the video adapter and click
Continue.
8. Click Finished to complete the setup.

4

Test Audio Adapter

To verify a successful
audio connection (for In-
tel® Wireless Music),
select the “Test your
audio connection” link
or select “Finished” to
bypass the test.

You can select “Play
O O Sample” to play an au-
dio test sample from
your adapter to the con-

nected speaker set.

Figure7- 69
Intel® WiDi
Connected
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Troubleshooting

Chapter 8: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sureit is actually working. Check the LED Power & Communication Indicators (see” LED Indica-
tors’ on page 1 - 9) to see the computer’s power status.

Connections - Check al the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
Ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
(thisis acommon cause of the message “I nvalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Super visor password for the BIOS (see “ The Setup Utility” on page5 - 2).

» Keep copiesof vital settingsfiles such as network, dialup settings, mail settings etc.(even if just brief notes).

N2
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

Install an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

* Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’'t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

» Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sureyou haveinstalled the driversfor any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).

.|
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn't | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator {_Ti], is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4) check its settings. You may also be using a
USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 11).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

. |
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Problem Possible Cause - Solution

The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 18). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the Touchpad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix C for instructions on installing and configuring
on. the video driver.

. |
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Problem Possible Cause - Solution

You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
I

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume | The volume might be set too low. Check the volume control in the Volume
is very low. Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 12) to adjust.

The volume balance cannot be adjusted | If you wish to adjust the left and right channel volume levels separately, you will
separately for the left and right | need to adjust this from the VIA HD Audio Deck in Expert Mode. See
channels from the Windows Sound | “Syncing Left & Right Volume Balance” on page 2 - 19.

control panel.

The CD/DVD cannot be read. The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when | The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
there is a disc in the tray. using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer | The code has been changed the maximum 5 times. See “DVD Regional
be changed. Codes” on page 2 - 5.
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Problem

Possible Cause - Solution

Unwelcome numbers when

typing.

appear

If the LED @ is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1-9).

work.

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system wiill
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 6). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth/3G
modules cannot be detected.

The modules are off. Check the LED indicator and/or function key indicator to
see if the WLAN/Bluetooth/3G module is on or off (see “LED Indicators” on
page 1 - 9). If the LED indicator is off, then press the Fn + F11 (WLAN), Fn +
F12 (Bluetooth) or Fn + (3G) key combination(s) in order to enable the
modules (see Table , on page 1 - 12).
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Problem

Possible Cause - Solution

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 12). Run the camera
application to view the camera picture.

The Wireless LAN/Bluetooth/ PC
Camera/3G modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the device to your computer until
the file transfer process from the computer has been completed.

The Bluetooth module is off after

resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

| am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.
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Problem Possible Cause - Solution

The Bluetooth module is experiencing
problems/ 2 Bluetooth adapters appear
in the Device Manager under Bluetooth
Radios.

There is a conflict between an existing Bluetooth module and a Bluetooth &
WLAN combination module. You should have only one Bluetooth module
installed in order to prevent any conflicts (this includes the Bluetooth
element of any combination WLAN & Bluetooth module). If you have an
existing Bluetooth module installed and then decide to add a combo WLAN &
Bluetooth module at a later date, then uninstall the original Bluetooth module
before installing the combo module.
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Problem Possible Cause - Solution

| cannot obtain high speed Bluetooth data | To obtain high speed Bluetooth data transfer take into account the following:
transfer.

e Only the combination Wireless LAN & Bluetooth module sup-
ports high speed data transfer.

» To achieve high speed transfer speeds, both devices must sup-
port high speed data transfer (i.e both the computer and the
Bluetooth compatible device you are connecting to).

» To obtain high speed data transfer make sure that both the com-
puter’'sWLAN and Bluetooth modules are powered on (use
the Fn + F11 to toggle power to the WLAN moduleand Fn + F12
to toggle power to the Bluetooth module).

» Check your Bluetooth compatible device's documentation to con-
firm it supports high speed data transfer, and for configuration
information.
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Bluetooth Connection Problems

If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Micr osoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver.

Install the Microsoft Windows Device Center Driver as appropriate for your operating system.

Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
Make sure the Bluetooth device is powered on.

Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and
Printers).

Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have
connected, or tried to connect to, a Bluetooth device previously).

PwDNPE

o

2¥ MNetwork adapters /
'3 Atheros ARS007EG Wireless Network Adapter
l&-"‘ Bluetooth Device (Personal Area Network)
5;-“ Bluetooth Device (RFCOMM Protocol TDI)

A

Bluetooth Peripheral Devices

l;‘ Marvell Yukon 88E8040 PCI-E Fast Ethernet Contreller You will need to repeat the procedure
4-llp Other devices : listed here for all Bluetooth Peripher-
i 4|7 Bluetooth Peripheral Device q A q

W PCIFLASH Memory .a| DeV|.ces listed under Other Devices
o) Processors i.e. until there are no more Bluetooth
>~ Sound, video and game controllers Peripheral Devices listed under this
P - Storage controllers menu heading_

ol Suertarn Asicar

Figure 8 - 1 - Device Manager

. |
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.

7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 2 - Browse my computer.../Let me pick from...

9. Select Bluetooth Radios from the list.

>

Figure 8 - 3 - Select Bluetooth Radios
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10. A list of drivers will appear with Manufacturer on one side and Model in the other.
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for
Microsoft Corporation to appear in the list).

12. Select Windows Mobile-based device support from the Model list.

@ [ Update Driver Software - Bluetooth Peripheral Device

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click MNext, If you have a
disk that contains the driver you want to install, click Have Disk.

Manufacturer * || Model
Microlink ch support
||

Make sure you select C — =]

Microsoft Corporation : 4

E This driver is digitally signed.

Tell me why driver signing is important

Figure 8 - 4 - Select Device Driver

13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.
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15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth
Radios.
16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

Figure 8 - 5 - Device Manager - Bluetooth Radio

. |
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Wake On LAN Setup

Wake On LAN is an Ethernet computer networking standard that allows a computer to be turned on or woken
up by anetwork message. If you need to have your computer Wake On L AN configure the settings as follows.

Go the Windows control panel and double-click Administrative Tools (System and Security).
Double-click Computer Management.

Click Device Manager under System Tools, and click the arrow to the left of Network adapters.
Double-click Realtek PCle GBE Family Controller, and click Power Management (tab).

Click to enable (place a check in the checkbox) “Allow this device to wake the computer”.
Click OK to close the menu, and close the Computer Management control panel.

ok wbpE

o> = >

Figure 8 - 6- Network Adapter Wake On LAN (Power Management)
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Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give aquick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

Interface (Ports & Jacks) A - 1
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Notebook Ports and Jacks

Item

Description

Card Reader Port

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA)

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or

Port simultaneous display on the LCD and external monitor/FPD.
e-SATA Port This is a combined e-SATA (external Serial Advanced Technology Attachment)/ USB 2.0
e-SATA compatible port. Plug external Serial ATA hard drives into this e-SATA (external Serial

Advanced Technology Attachment) port.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

A - 2 Interface (Ports & Jacks)
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Item Description
Microphone-In Jack Plug an external microphone in to this jack to record on your computer.
RJ-45 LAN Jack This port supports LAN (Network) functions.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Port These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
USB 3.0 Ports power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB
3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7) and does
not support wake on USB.
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Appendix B: Control Center

Overview

Thefollowing chapter will give aquick description of the functions of the Control Center. The Control Center
givesquick accessto frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center iconsto toggle the appropriate function, or hold the mouse button down

and move the slider where applicable. Certain functions will automatically be adjusted when a power mode is
selected.

Figure B - 1 - Control Center
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Power Modes
Y ou can set a Power M ode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the power status of modules (e.g. WLAN, Bluetooth, 3G or Camera), screen brightness,

TouchPad power and Silent Mode.

You can click aControl Center icon to set an overall power mode and then click individual iconsin the
Control Center to power on/off any modules etc.

Thetableoverleaf illustrates the basic settingsfor each power mode. If you choose user defined the settings
will correspond to your selected system settings.

. |
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. . . . User
Modes Power Saving Flight Entertainment Quiet Performance Defined
Icon ” '
£ 3
Power Plan Power Saver Balanced Power Saving Power Saving High Performance
Power Conservation Mode Energy Star BIOS Default Energy Star Energy Star Performance
Brightness 14 42 100 42 100
WLAN OFF OFF ON ON ON c
8
o}
Bluetooth BIOS Default o
3
(=8
3G OFF OFF OFF OFF OFF
PC Camera OFF OFF OFF ON ON
TouchPad ON ON ON ON ON

Table B - 1- Power Modes

. |
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Power Status

The Power Status icon wiil show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness

The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again). Note that screen brightness is also effected by the Power M ode selected (see
TableB - 1, on page B - 3).

Volume
The Volume icon will show the current volume level. Y ou can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Power Conservation

This system supports Ener gy Star power management features that place computers (CPU, hard drive, etc.) into
alow-power sleep modes after a designated period of inactivity (see“ Power Conservation Modes’ on page 3 -
10). Click either the Perfor mance, Balanced or Energy Star button.
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Sleep
Click the Sleep button to bring up the Hiber nate or Sleep buttons, and click either button to have the
computer enter the appropriate power-saving mode (see “ Power-Saving States” on page 3 - 6).

Display Switch
Click the Display Switch button to access the menu (or use the & + P key combination) and select the appro-
priate attached display mode (see page C - 12).

Time Zone
Clicking the Time Zone button will access the Date and Time Windows control panel.

Desktop Background
Clicking the Desktop Background button will alow you to change the desktop background picture.

TouchPad/PC Camera/Wireless LAN Module /Bluetooth/3G Module
Click any of these buttonsto toggle the TouchPad or modul €’ s power status. A crossed out icon will appear over

the top left of theicon when it is off. Note that the power status of a module, and TouchPad power, is also
effected by the Power Mode selected (see Table B - 1, on page B - 3). E

Caps Lock/Scroll Lock/ Number Lock 8 & &
Click the button to toggle the appropriate lock mode.
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Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features’ on
pagel - 22.

Video Driver Installation

Make sureyou install the driversin the order indicated in Table 4 - 1, on page 4 - 3.
Insert the Device Drivers & Utilities+ User’sManual disc and click Install Drivers
(button).

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes> Next > Next.

3. Click Finish to restart the computer.

NVIDIA Video (VGA)

1. Click 3.Install nVIDIA VGA Driver > Yes.

2. Click AGREE AND CONTINUE (button) to accept the terms of the
license agreement.

3. Click Next.

4. Click the RESTART NOW button to restart the computer.

Video Driver Installation C - 1

4

Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.
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4

iGPU or dGPU

Note the NVIDIA control
panel refers to High-
performance NVIDIA
processor (which is the
discrete GPU) and Inte-
grated graphics (which
is the integrated GPU).

NVIDIA® Optimus™ Technology

Most notebook computers come with either adiscrete or integrated graphics solu-
tion.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU)
which are capable of playing games, watching HD video or running GPU-based ap-
plications. However computers with discrete graphics solutions tend to be heavy in
power consumption, and slightly larger in size in order to incorporate the dedicated
discrete GPU.

Integrated graphics solutions usually feature memory sharing technology to help
save power consumption and allow for longer battery life. However computers with
integrated graphics solutions will not usually run games, HD video or GPU-based
applications without severe limitations.

Nvidia® Optimus™ technology is a seamless technology designed to get best per-
formance from the graphics system while allowing longer battery life, without hav-
ing to manually change settings. Thus when an application is run that requires extra
performance or quality, then the system will run the discrete GPU (dGPU); when the
system does not require such enhanced performance it will let the integrated (iGPU)
handle it.

C - 2 NVIDIA® Optimus™ Technology
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How Optimus Technology works

When the system is powered up and is displaying just the desktop, the dGPU will be
powered off. In this case the system is running in the same way as a system without
a discrete graphics solution. However when an application that requires use of the
dGPU isrun (e.g, agame or HD Video), the dGPu is powered on and takes over the
processing duties. If the program is closed, then the dGPU will be powered back
down again until required.

.|
NVIDIA® Optimus™ Technology C - 3

4

Customization
Options

Although Optimus is
completely seemless to
the user, NVIDIA also
allow customization op-
tions within the control
panel (see “Optimus™
Customization Op-
tions” on page C - 18).



Video Driver Controls

4

Application Mode

Note that all figures pic-
tured, and instructions
outlined here are based
on the Advanced Ap-
plication Mode.

FigureC-1
Intel® G&M
Control Panel

C - 4 Intel® Graphics

Intel® Graphics & Media Control Panel

Advanced video configuration options are provided by the Intel® Graphics and
Media Control Panel. To access the control panel:

1. Click Advanced settings in the Screen Resolution control panel in Windows.

2. Click the Intel(R)... tab and click Graphics Properties (button).

OR

3. Right-click the desktop and select Graphics Properties from the menu.

OR

4. Double-click the Intel(R) G&M control panel in Windows.

5. Choose the application mode (Basic, Advanced or Wizard) required (see sidebar).

>

& Media Control Panel
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Y ou may make changes to any of the graphics properties by clicking the appropriate
menu tab on the left of the menu and adjusting the settings on the right. Z

Options & Support

Click Options & Sup-
port and select an item
from the sub-menu to
bring up the help and
support topics.

You will need to be con-
nected to the Internet to
access the key resource
links.

Multiple Display

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

FigureC- 2
Intel® G&M

Control Panel Tabs

Intel® Graphics & Media Control Panel C - 5
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4

Function Key
Combination

You can use the Fn + F7

key combination to tog-

gle through the display

options:

* Notebook Only

« External Display Only

» Notebook + External
Display

Make sure you give the

displays enough time to
refresh.

Note that HDMI sup-
ports video and audio
signals.

TableC-1
Display Modes

Display Devices & Options

Besidesthe built-in LCD you can also use an external monitor/flat panel display/TV
connected to the external monitor port or to the HDMI-Out port (High-Definition
Multimedia Interface) as your display device. The table below outlines the display
options.

4
Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
G&M control panel to configure the full screen display.

Intel Display Mode Description

Single Display One of the connected displays is used as the display device

Both connected displays output the same view and may be

Clone Displays configured independently

Both connected displays are treated as separate devices, and

Extended Desktop act as a virtual desktop

C - 6 Intel® Graphics & Media Control Panel
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Attaching Other Displays

4
If you prefer to use amonitor or flat panel display, connect it to the external monitor N
port or HDMI-Out port on the left of the computer. IR IR ]

At least one other dis-

To Clone Displays: play must be attached in

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on. order to view Multiple
2. Gotothe Intel(R) G&M control panel and click Display > Multiple Displays. Display selection op-
3. Click Operating Mode and select Clone Displays from the menu. tions.

4. Click Apply, and OK to confirm the settings change.

5. You can switch the Primary/Secondary Display from the menu. General Settings

Click General Settings
to access settings the
options for any attached
display.

FigureC- 3
Display > Multiple

Displays (Clone)

Attaching Other Displays C - 7
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To Enable Extended Desktop:
4 1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.

: . 2. Gotothe Intel(R) G&M control panel and click Display > Multiple Displays.
Display Settings ; )
Extended Desktop 3. Click Operating Mode and select Extended Desktop from the menu.
4. Click Apply, and OK to confirm the settings change.

You can have different ] ) ]
Colors, Screen Area Click the appropriate monitor
and  Monitor Refresh icon and drag it to match the
Reize i et clgpey physical arrangement you
device provided your ish h d
monitor can support Wi .'[O use (e.g. the second-
them. ary display may be extended

_ left/right/above/below  the
You can drag the moni- . disol
tor icons to match the primary disp ay)
physical layout of your
displays. Icons and pro- Click Genera Settings to
grams may also be make any adjustments re-
dragged between the :

: quired.

displays.

C FigureC-4
Display > Multiple

Displays (Extended)

C - 8 Attaching Other Displays
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Display Profiles
Y ou can save display settings to be loaded at any time.

1. Goto the Intel(R) G&M control panel and click Display.

2. Configure the General Settings, Multiple Displays, Color Enhancement, Custom
Resolution & Monitor/TV Settings to your preferences.

3. Click Apply, and OK to confirm the settings change.

4. Click the Save button at the top of the General Settings, Multiple Displays or Color
Enhancement menus (under Display Profiles).

5. Type a name for the Profile and click OK.

6. The Profile will be listed under Display Profiles.

7. Select the profile from the pull-down menu and click Apply, and OK to confirm the
settings change.

FigureC-5
Intel® G&M
Profiles

.|
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Function Key
Combination

You can use the Fn +

F7 key combination to

toggle through the dis-

play options:

» Notebook Only

» External Display
Only

» Notebook + External
Display

Make sure you give the

displays enough time

to refresh.

Note that HDMI sup-
ports video and audio
signals.

FigureC-6
Screen Resolution
Multiple Displays

(Win 7)

Video Driver Controls

Configuring an External Display in Windows 7

Y ou can also use the Screen Resolution control panel in Windows 7 to configure an

external display.

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.

2. Go to the Screen resolution control panel (see “Video Features” on page 1 -
22).

3. Click the Detect button.

4. The computer will then detect any attached displays.

>

C - 10 Configuring an External Display in Windows 7
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5. You can configure the displays from the Multiple Displays menu.

FigureC-7
Screen Resolution
Multiple Display
Options
(Win 7)

» Duplicate these displays - Shows an exact copy of the main display desktop on
the other display(s)

» Extend these displays - Treats both connected displays as separ ate devices

» Show desktop only on 1/2 - Only one of your displaysis used.

.|
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Using the Windows Logo Key g + P Key Combination to Switch Displays

You can also usethe g + P key combination to quickly change display configura-
tion and modes (thisis particularly useful when attaching a projector) in Windows 7.

Attach your display to the external monitor port or HDMI-Out port, and turn it on.
Press the 2= + P key combination.

An on-screen menu will pop up.

Use the cursor keys (or & + P) to select the appropriate configuration from the
menu, and press Enter to confirm the selection.

PR

FigureC- 8
sz + P Display
Configuration
Selection
(Win 7)
Y ou can also use the Display Switch button inthe Control Center to accessthe
menu and select the appropriate attached display mode.

.|
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HDMI Audio Configuration

HDMI (High-Definition Multimedia I nterface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1.
2.
3.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound  (Hardware and Sound) and click Playback (tab)

Depending on your display, the playback device may be selected, however in some
cases you may need to select the audio device and click Set Default (button).
Double-click the device to access the control panel tabs illustrated overleaf.

4

Volume Indicator

Click the taskbar volume
indicator ] when an
HDMI device is select-
ed, and you will note that
the icon at the top of the
volume level indicator
has changed.

FigureC-9
Sound - HDMI
Device (set Default)

HDMI Audio Configuration C - 13
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5. Double-click the connected HDMI device (or right-click and select Properties) to
adjust the HDMI settings from the control panel tabs.
6. Click OK to close the control panel (see notes overleaf).

FigureC- 10
HDMI Device
Properties

C - 14 HDMI Audio Configuration
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HDMI Notes

Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

To play audio sources through your external display’s (TV or LCD) speakers
you will need to go to the audio configuration control panel on the display and
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration

1.
2.

3.

4,

Connect an HDMI cable from the HDMI-Out port to your external display.
Configure your external display as per the instructions in “Attaching Other
Displays” on page C - 7.

Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

You can now play video/audio sources through your external display.

THX TruStudio Pro & HDMI

1.

2.

HDMI Audio Configuration C - 15

When you connect an HDMI display to the HDMI-Out port, the THX TruStudio Pro
controls will be disabled.

A warning box will pop-up and will prompt “Do you want to select another audio
device now?”.

Click No to continue using the HDMI audio output from your external display (do
not attempt to select another audio device when connected to the external HDMI
display.

4

Other Applications

If you are using a third
party application to play
DVDs etc. from any at-
tached DVD device,
you will need to consult
the application’s docu-
mentation to see the
appropriate audio con-
figuration (the applica-
tion must support digital
to analog translation).
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4

NVIDIA Control
Panel

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

FigureC- 11
NVIDIA GeForce.....
Control Panel

NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the
menu if you are in Control Panel Home).

. |
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The NVIDIA Control Panel provides additional video configuration controls and

tools which allow quick access to features such as image settings, 3D Settings and A

video configuration. Navigating the
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.

Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

FigureC- 12
NVIDIA Control
Panel

. |
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4

Display GPU
Activity Icon

Click to enable Dis-
play GPU Activity
Icon in the Notifica-
tion Area to quickly
access the GPU Activ-
ity monitor from the
taskbar.

FigureC - 13
NVIDIA Control
Panel - View

Optimus™ Customization Options

One of the most important aspects of Nvidia® Optimus™ technology is that it will
switch between the integrated GPU and discrete GPU seemlessly and automatically,
and does not require any input from the user. However customization options are of -
fered for users who prefer to set their own parameters for GPU usage.

Context Menu

One of the quickest ways to choose which GPU to use for aparticular applicationis
by using the “Run with graphics processor” in the context menu.

1. Runthe NVIDIA Control Panel (see page C - 16).
2. Click Desktop from the top menu and select Add “Run with graphics
processor” to Context Menu (it should have a tick alongside it).

-

C )
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Close the NVIDIA Control Panel.
Find the executable file icon of the application you want to run. 4
Right-click the icon and select Run with graphics processor from the context

MenL. iGPU or dGPU
Select either High-performance NVIDIA processor (dGPU) or Integrated Note the NVIDIA con-
graphics (iGPU) to run the program with the selected GPU. trol panel refers to

High-performance

NVIDIA processor
(which is the discrete
GPU) and Integrated
graphics (which is the
integrated GPU).

C )
FigureC- 14
Context Menu with
Run with graphics
processor
Right-click the application executablefile

Optimus™ Customization Options C - 19
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Global Settings
Global settings allows you to set the preferred graphics processor for overall use.
Ideally thiswould be theiGPU for battery life, but this can be set to the dGPU if pre-

ferred.

1. Runthe NVIDIA Control Panel (see page C - 16).

2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab).

3. Select either Integrated graphics (iGPU) or High performance NVIDIA
Processor (dGPU) from the drop-down menu.

4. Click the Setting menu items to select any options required.

5. Click Apply to save the settings.

FigureC- 15
Global Settings

2
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Program Settings
Program settings allows you to make specific adjustments for installed applications.

1.
2.
3.

Run the NVIDIA Control Panel (see page C - 16).

Click Manage 3D Settings (3D Settings) and select Program Settings (tab).
Select a program to customize from the drop-down menu, or click Add to add
any program that does not appear in the menu.

Click the drop-down menu under Select the preferred graphics processor for
the program to select the graphics processor.

Click the Setting menu items to select any options required.

Click Apply to save the settings.

FigureC- 16
Program Settings

O
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Set PhysXe Configuration

NVIDIA® PhysX® isa physics engine that can use the GPU to accelerate game and
3D application performance. Y ou can select the GeForce video card or CPU as a
PhysX® processor, or configure the computer to auto-select a PhysX® processor
(recommended default setting).

1. Goto NVIDIA Control Panel (see page C - 16).

2. Click Set PhysX configuration.

3. Click to Select a PhysX processor from the menu; Auto-select (recommended) is

the default setting.
4. Click Apply to save the settings.

FigureC- 17
Set PhysX®
Configuration

.|
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Video Settings

Click the sub-menus under Video to adjust the video color or image settings.

FigureC- 18
Video Settings

Video Settings C - 23
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Appendix D: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.

.|
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Intel® Core i7-3840QM (2.8GHz)
Quad-Core Mobile Processor

8M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-3820QM (2.7GHz)
Quad-Core Mobile Processor

8M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-3740QM (2.7GHz)
Quad-Core Mobile Processor

6M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-3720QM (2.6GHz)
Quad-Core Mobile Processor

6M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-3610QM (2.3GHz)
Quad-Core Mobile Processor

6M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 45W

D - 2 Specifications

Intel® Core i7-3520M (2.9GHz)
Mobile Processor

4M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3360M (2.8GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3320M (2.6GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3210M (2.5GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i5-3110M (2.4GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3-1600MHz, TDP 35W

Intel® Core i7-2860QM (2.5GHz)
Quad-Core Mobile Processor

8M L3 Cache, 32nm (32 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-2820QM (2.3GHz)
Quad-Core Mobile Processor

8M L3 Cache, 32nm (32 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-2760QM (2.4GHz)
Quad-Core Mobile Processor

6M L3 Cache, 32nm (32 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-2720QM (2.2GHz)
Quad-Core Mobile Processor

6M L3 Cache, 32nm (32 Nanometer),
DDR3-1600MHz, TDP 45W

Intel® Core i7-2670QM (2.2GHz)
Quad-Core Mobile Processor

6M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 45W

Intel® Core i7-2630QM (2.0GHz)
Quad-Core Mobile Processor

6M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 45W
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Intel® Core i7-2640M (2.8GHz)
Mobile Processor

4M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i7-2620M (2.7GHz)
Mobile Processor

4M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2540M (2.6GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2520M (2.5GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2450M (2.5GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2430M (2.4GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i5-2410M (2.3GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2370M (2.4GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2350M (2.3GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2330M (2.2GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Core i3-2310M (2.1GHz)
Mobile Processor

3M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B970 (2.3GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B960 (2.2GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B950 (2.1GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Intel® Pentium® B940 (2.0GHz)
2M L3 Cache, 32nm (32 Nanometer),
DDR3-1333MHz, TDP 35W

Mobile Intel® HM76 Express Chipset
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Models A & C:

15.6"/ 39.62cm HD (1366 * 768) / HD+
(1600 * 900) / FHD (1920 * 1080) 16:9
Backlit Panel

Models B & D:
17.3"/ 43.94cm HD+ (1600 * 900) / FHD
(1920 * 1080) 16:9 Backlit Panel

Dual Channel DDRIII (DDR3)

Two 204 Pin SO-DIMM sockets
supporting DDR3 1333MHz/1600MHz
(real operational frequency depends on
the FSB of the processor)

Memory Expandable up to 16GB (using
2GB /4GB / 8GB SO-DIMM Modules)

Intel® Integrated GPU and NVIDIA®
GeForce GT 635M OR GT 645M Video:

Supports NVIDIA® Optimus
Switchable GPU Technology between
iGPU and dGPU

Intel® HD Graphics 4000 / Intel® HD
Graphics 3000 / Intel® HD Graphics
(GPU is Dependent on Processor):

Dynamic Frequency

Intel Dynamic Video Memory Technology
forup to 1.7GB

Microsoft DirectX®10 Compatible (for
Intel® HD Graphics 3000 / Intel® HD
Graphics)

Microsoft DirectX®11 Compatible (for
Intel® HD Graphics 4000)

For Models A & B Only:

NVIDIA® GeForce GT 635M Discrete
GPU:

1GB DDR3 Video RAM

Supports PCle * 8

Microsoft DirectX®11 Compatible
NVIDIA PhysXx™

GeForce CUDA™ Technology
NVIDIA® Optimus 2012 Technology

For Models C & D Only:

NVIDIA® GeForce GT 645M Discrete
GPU:

1GB DDR3 Video RAM

Supports PCle * 8

Microsoft DirectX®11 Compatible
NVIDIA PhysX™

GeForce CUDA™ Technology
NVIDIA® Optimus 2012 Technology

48Mb SPI Flash ROM
AMI BIOS
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) One Microphone-In Jack )
One Changeable 12.7mm(h) Super Multi/ One RJ-45 LAN Jack Built-In 10/100/1000Mb Base-TX Ethernet

Blu-ray Combo Optical Device Drive with LAN
SATA Interface (Factory Option) One DC-In Jack

. Intel® Centrino® Advanced-N 6235 (2*2
One Changeable 2.5/ 9.5 mm (h) HDD _ 802.11 a/g/n) Half Mini-Card PCle WLAN &

with SATA (Serial) Interface

Embedded Multi-in-1 Card Reader Bluetooth 4.0 Combo Module (Factory Op-
- SD/ Mini SD / SDHC/ SDXC : :
High Definition Audio Interface _MS/ MS Pro/ MS Duo Intel® Centrino® W!reless-N 2230 (1*2
Built-In Microphone 802.11 b/g/n) Half Mini-Card PCle WLAN &
2 * Built-In Speakers Note: Some of these cards require PC Bluetooth 4.0 Combo Module (Factory Op-
i i tion
THX TruStudio Pro adapters that are usually supplied with )
the cards.

Combo WLAN (802.11b/g/n) and
Module with PCle Interface (Factory

Eor Models A & C - Two Mini-Card Slots: Option)

Full Size Isolated Keyboard with Numeric

Keypad
Bui}llt?in Touchpad with Multi-Gesture and Slot 1 for_HaIf Size WLAN Combo .

. . . Module with PCle and USB Interface WLAN 802.11b/g/n Half Mini-Card Module
scrolling Functionality Slot 2 for Full Size 3G Module with USB || With PCle Interface (Factory Option)
One USB 2.0 Port For Models B & D - One Mini-Card Slot:

Two USB 3.0 Ports For Half Size WLAN Combo Module with
One eSATA Port PCle and USB Interface

One External Monitor Port
One HDMI-Out Port (with HDCP)
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2.0M HD PC Camera Module with USB

interface (Factory Option)
Supports Wake on LAN Models A & C:
) 374mm (w) * 250mm (d) * 14.3 - 37.2mm (h)
e sacoy | I |
374 *25.0 d) *20 - 37.2 h
based 3G Module with Mini-Card FuII.Range AC/DC Adapter mm () mm (d) mm ()
Interface (Factory Option) AC input 100 - 240V, 50 - 60Hz, 2.6 kg with ODD & 48.84WH Battery
Quad-band GSM/GPRS (850 MHz, 900 DC Output 19V, 4.74A (90 Watts)
MHz, 1800 MHz, 1900 MHz) Removable 6 Cell Smart Lithium lon Battery || Models B & D:
UMTS WCDMA FDD (2100 MHz) Pack 48.84WH 413mm (w) * 270mm (d) * 14 - 40.5mm(h)
Note that UMTS modes CAN NOT be -
used in North America Removable 6 Cell Smart L|th|u_m lon Battery 3kg with ODD & 48.84WH Battery
Pack 62.16WH (Factory Option)

Security (Kensington® Type) Lock Slot
BIOS Password

Windows® 7 with Service Pack 1

. Temperature
Painted Style Covers (For Some Model )
Designs) y ( Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
IMR (Injected Molded Resin) LCD Back
Covers (For Some Model Designs) Relative Humidity
] Operating: 20% - 80%
Supports Intel® Anti-Theft Technology Non-Operating: 10% - 90%
Supports Intel® Smart Connect
Technology
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